Custom Datasource For TIBCO Spotfire® To Read Data From The OSIsoft® PI System®

User Guide
1. Introduction .......................................................................................................................... 7
   Key Capabilities ..................................................................................................................... 8
   Retrieving PI Tag Lists ...................................................................................................... 8
   Retrieving PI Tag Data ...................................................................................................... 8
   Retrieving AF Elements, Metadata and Data .................................................................. 9
   Retrieving Event Frame Data .......................................................................................... 9
   Work in any Spotfire Client .............................................................................................. 10
   Secure Access ................................................................................................................... 10
   Application Building Features ....................................................................................... 11

2. Installation and Configuration .......................................................................................... 12
   Package Contents ............................................................................................................. 12
   System Requirements ..................................................................................................... 12
   Software Pre-Requisites .................................................................................................. 12
   Installation ......................................................................................................................... 12
   Updating Web Player and Automation Services ............................................................ 13
   Spotfire Licenses .............................................................................................................. 13
   Spotfire Preferences ......................................................................................................... 14
   Validating the Installation .................................................................................................. 15
   Troubleshooting ................................................................................................................ 16

3. Retrieving A List Of OSIsoft PI Tags .............................................................................. 17
   Configuration Dialog ....................................................................................................... 17
   Connection Tab ................................................................................................................... 18
   Tag List Parameters Tab ................................................................................................... 19
   Attribute Retrieval Tab ..................................................................................................... 20
   Data Validation .................................................................................................................. 20
   Data Returned ..................................................................................................................... 21
   Resizing ............................................................................................................................... 21

5. Retrieving OSIsoft PI Tag Data ....................................................................................... 22
   Configuration Dialog ....................................................................................................... 22
   Connection Tab ................................................................................................................... 23
   Tag Selection Tag ............................................................................................................... 24
   Data Retrieval Tab ............................................................................................................. 24
   Data Validation .................................................................................................................. 25
   Data Returned ..................................................................................................................... 26
6. Retrieving OSIsoft PI Calculation Data ........................................... 27
   Configuration Dialog ............................................................................. 27
   Connection Tab ...................................................................................... 28
   Data Retrieval Tab ................................................................................ 29
      Calculate At Intervals ......................................................................... 30
      Calculate At Recorded Values ............................................................ 30
      Calculate At Times ............................................................................ 31
      Calculate Summaries ......................................................................... 32
   Data Validation ....................................................................................... 33
   Data Returned ........................................................................................ 34
   Resizing ................................................................................................. 34

7. Retrieving OSIsoft Asset Framework™ Metadata & Data ................... 35
   Configuration Dialog ............................................................................. 35
   Connection Tab ...................................................................................... 36
   Elements and Attributes Tab ................................................................. 36
   AF Attributes ......................................................................................... 37
   Data Retrieval Tab ................................................................................ 38
   Data Validation ....................................................................................... 39
   Resizing ................................................................................................. 40

8. Retrieving OSIsoft Event Frame Metadata & Data .............................. 41
   Configuration Dialog ............................................................................. 41
   Connection Tab ...................................................................................... 42
   AF Event Frames Tab ............................................................................. 42
   Data Retrieval ....................................................................................... 44
   Data Validation ....................................................................................... 45
   Resizing ................................................................................................. 45

9. Using the OSIsoft PI Tag List Data Function ......................................... 46
   Setup....................................................................................................... 46
   Edit Parameters Dialog .......................................................................... 46
   Making Configuration Changes ............................................................. 48
   Example Use Cases ............................................................................... 48
   Input Parameters .................................................................................... 49
10. Using the OSIsoft PI Tag Data Function .................................................. 50
    Setup ........................................................................................................ 50
    Edit Parameters Dialog ........................................................................... 50
    Making Configuration Changes ............................................................... 52
    Example Use Cases ................................................................................ 52
    Input Parameters .................................................................................... 53

11. Using the OSIsoft Calculations Data Function ...................................... 54
    Setup ........................................................................................................ 54
    Edit Parameters Dialog ........................................................................... 54
    Making Configuration Changes ............................................................... 56
    Example Use Cases ................................................................................ 56
    Input Parameters .................................................................................... 57

12. Using the OSIsoft AF Attribute Data Function .................................... 58
    Modes ...................................................................................................... 58
    Setup ........................................................................................................ 58
    Edit Parameters Dialog ........................................................................... 59
    Making Configuration Changes ............................................................... 60
    Example Use Cases ................................................................................ 61
    Input Parameters .................................................................................... 62

13. Using the OSIsoft AF Event Frame Data Function ............................... 63
    Modes ...................................................................................................... 63
    Setup ........................................................................................................ 63
    Edit Parameters Dialog ........................................................................... 64
    Making Configuration Changes ............................................................... 65
    Example Use Cases ................................................................................ 66
    Input Parameters .................................................................................... 67

14. Using the Password Encryption Tool .................................................... 68
    Controlling Access via Licenses ............................................................... 68

15. IronPython Scripting .............................................................................. 69
    Spotfire and System References .............................................................. 69
    Table Plot Creation Code ........................................................................ 69
    Tag List DataSource ................................................................................ 70
    Required References .............................................................................. 70
1. Introduction

The PI System is a suite of software products that are used for data collection, historicizing, finding, analyzing, delivering, and visualizing. It is marketed as an enterprise infrastructure for management of real-time data and events. The term PI System is often used to refer to the PI Server but the two are not same. The PI System refers to all OSIsoft software products whereas the PI Server is the core product of the PI System.

The Field Connectivity Framework is a set of custom built TIBCO Spotfire® Extensions along with working samples that enable users to build interactive visualizations on top of data stored in one or more OSIsoft PI Systems.

The following custom components are currently provided:

- A set of TIBCO Spotfire® Custom Datasources that can read data and metadata from OSIsoft PI, AF and Event Frame data into memory
- A set of TIBCO Spotfire® Custom Data Functions that allow dynamic data retrieval from all the above Datasources based on Marking and Filtering, Document Properties or Script execution
- A Custom Tool to allow the encryption of passwords to be used in Data Function calls

This document will walk through the components, how to install them and how to use them.
Key Capabilities

Retrieving PI Tag Lists
One of the most common tasks is to retrieve a list of PI Tags within one or more PI Systems.

This is provided via the Tag List Datasource, which allows searching for PI Tags using multiple criteria and retrieving the list into Spotfire memory along with their metadata attributes.

![Figure 1: Retrieving a list of OSIsoft PI Tags](image1)

Retrieving PI Tag Data
Once one or more PI Tags have been identified the next objective is to retrieve time series data for those tags.

This is provided via the Tag Data data-source, which allows searching for PI Tags across multiple PI Systems and retrieving their data for a specified time period.

![Figure 2: Retrieving PI Tag Data](image2)

In addition, Tag Data can be retrieved using the OSIsoft Performance Expression (PE) syntax.
Retrieving AF Elements, Metadata and Data

The AF data-source allows the retrieval of lists of AF Elements along with their Attributes and Data across multiple PI Systems and AF Databases.

The hierarchy of AF Elements and AF Attributes is also retrieved to allow the construction of more complex analytic applications.

Retrieving Event Frame Data

The Event Frame data-source allows the retrieval of lists of AF Elements along with their Attributes and Data across multiple PI Systems and AF Databases.
The hierarchy of AF Elements and AF Attributes is also retrieved to allow the construction of more complex analytic applications.

![Figure 5: Retrieving Event Frame Data](image)

**Work in any Spotfire Client**
Visualizations using any of the data-sources must be authored in Spotfire Analyst, but can then be consumed in Spotfire Analyst and/or Spotfire Consumer. They can also be used with Spotfire Automation Services to allow batch processing scenarios.

**Secure Access**
Wherever possible, the integrated security of OSIsoft PI System should be used to avoid the need for usernames and passwords. However, if absolutely necessary, passwords can be encrypted before being embedded in Analytic Applications.

![Figure 6: Password Encryption Tool](image)
Application Building Features

The Data Functions provided allow the dynamic retrieval of data and metadata based on Marking and Filtering changes along with Document Properties and IronPython Script execution. This allows powerful analytic applications to be constructed quickly and easily.

Figure 7: Simple Example of Building an Analytic Application
2. Installation and Configuration

Package Contents
The installation package consists of a zip file that contains the following folders:

- “For Spotfire Server” – this folder contains the deployable modules for the package. These Spotfire Packages (SPK files) must be deployed onto the Spotfire Server by your System Administrator.

- “Documentation” - this folder contains this User Guide.

System Requirements
The Custom Datasources can be used with Spotfire 7.5 and above. The minimum requirements for the specific version of Spotfire being used can be found at the Spotfire Support Site http://support.spotfire.com/sr.asp.

Software Pre-Requisites
The Custom Data Source requires the “OSIsoft Asset Framework Client Library Version 4.0 (2015)” or newer to be installed. This software can be obtained via the OSIsoft Support website.

IMPORTANT: This applies to computers running Spotfire Analyst and to any servers running Spotfire Web Player or Spotfire Automation Services.

Installation
The Custom Datasources are installed by adding the .SPK files from the “For Spotfire Server” folder to a Spotfire Distribution on the Spotfire Server:

- SpotfirePS.Framework.OSIAFDataSource.spk
- SpotfirePS.Framework.OSIAFDataSourceForms.spk
- SpotfirePS.Framework.O SIPIDataSource.spk
- SpotfirePS.Framework.O SIPIDataSourceForms.spk
- SpotfirePS.Framework.O SIEncryptPassword.spk

This is the same process that is used for Hotfix installation. See the following section in the Spotfire Server Installation and Administration Manual for more details:
• **Adding software packages to a deployment area**

When Spotfire Analyst is next started it will prompt that updates are available and the packages will be downloaded. However the Web Player and Automation Services Servers must be updated manually as described in the following sections.

**Updating Web Player and Automation Services**

Web Player and Automation Services will need to be updated using the Spotfire Server web administration portal. See the following sections in the Spotfire Server Installation and Configuration Manual for more details:

• **Updating Services**

This update will require the Web Player and Automation Services instances to be restarted.

**Spotfire Licenses**

There are multiple licenses that control access to the various Datasources and Data Functions.

![Figure 8: TIBCO Spotfire Licenses Available](image)

The first group of Licenses determine which Datasources a user has access to:

• **OSIsoft PI Tag List Datasource** – allows retrieval of lists of PI Tags and their metadata
• OSIsoft PI Tag Datasource – allows retrieval of PI Tag data
• OSIsoft PI Calculations Datasource – allows retrieval of PI Tag data using OSIsoft Performance Expression syntax
• OSIsoft PI AF Element Datasource – allows retrieval of AF Element data and metadata

The second group of Licenses mirror the first set but control access to Data Functions associated with each Datasource:

• OSIsoft PI Tag List Data Function
• OSIsoft PI Tag Data Function
• OSIsoft PI Calculations Data Function
• OSIsoft PI AF Element Data Function
• Users can be licensed for individual Datasources and individual Data Functions, but if a user is licensed for a Data Function, they must also be licensed for the corresponding Datasource.

The final license controls access to a tool that allows the encryption of passwords that are to be used with any of the above Data Functions:

• OSIsoft Datasource Password Encryption Tool

**Spotfire Preferences**

There are three Preferences that allow System Administrators to disable the use of explicit logins, usernames and password, for Groups of Users.

The first two Preferences apply to the Tag List, Tag Data and Calculations Data Sources:

• Disable PI Explicit Login – prevents the use of PI Server credentials
• Disable Windows Explicit Login – prevents the use of windows credentials
The remaining Preference applies to the Asset Framework and Event Frame Data Sources:

- Disable Windows Explicit Login – prevents the use of windows credentials

Setting the value to True has the following effect:

- The selected option (in this example, PI Logins) on the Data Source Connection tab will be disabled:

![Data Source Connection Tab](image)

- Using the selected option (in this example, PI Logins) in a Data Function will cause an error:

![Data Function Error](image)

### Validating the Installation

Once the Datasource is correctly installed, licensed users should see additional options under the File Menu as shown below. Note the order of the items may vary on your system and is not important.
Licensed Users should also see entries for each Data Function and the Password Encryption Tool under the Tools Menu as shown below.

![Figure 10: File Menu Items for a Correct Installation](image)

![Figure 11: Tools Menu Items for a Correct Installation](image)

**Troubleshooting**

In the event of problems or errors during the installation, see Appendix F for a list of common errors and possible resolutions.
3. Retrieving A List Of OSIsoft PI Tags

Select the File → Open From → OSIsoft® PI™ Tag List… menu item as shown:

![Opening a list of PI Tags from the Menu](image)

**Figure 12**: Opening a list of PI Tags from the Menu

**Configuration Dialog**

The configuration dialog allows you to choose how to search for and retrieve a list of tags from a PI Server.

![Tag List Configuration Dialog](image)

**Figure 13**: Tag List Configuration Dialog

When first opened the dialog controls are disabled with the exception of the “Connection” tab and its controls. Once a connection to a PI Server has been successfully created the “Tag List Parameters” and “Attribute Retrieval” tabs, and their controls, become enabled.
Connection Tab

These controls allow you to choose how you will authenticate with the PI Server. There are 3 options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI Server*</td>
<td>In this mode you authenticate using a username and password setup directly on the PI Server. In this mode the domain option is not needed and is disabled.</td>
</tr>
<tr>
<td>Windows* Explicit</td>
<td>In this mode you authenticate using a Windows Domain account that has been configured on the PI Server to have access. You will need to enter the Windows Account Username, Password and Domain.</td>
</tr>
<tr>
<td>Windows Integrated</td>
<td>In this mode you authenticate using your current Window Domain Account (the one you are logged in as). In this mode, all credentials fields are disabled.</td>
</tr>
</tbody>
</table>

* - These options can be disabled to prevent the use of usernames and passwords. See “Spotfire Preferences” in Chapter 2 for more details.

After selecting the required connection mode and entering the required fields, press the “Connect…” button. If successful, the remaining dialog tabs and controls will be enabled. If the connection is unsuccessful, an error message will be displayed. For possible troubleshooting steps, see Appendix F.
Tag List Parameters Tab

These fields allow you to specify the search criteria when retrieving the list of tags from the PI Server.

- **Name** – return Tags whose Name match the specified search string. Asterisk * can be used as a wildcard.
- **Search Descriptor as well** – when checked, the same search that is specified in the Name field will be performed on the Descriptor field as well. So Tags that have a matching Name OR Descriptor will be returned.
- **Point Source** – return Tags whose Point Source definition matches the specified search string
- **Data Type** – return Tags of a particular Data Type or all Data Types. E.g. Float, Int32 etc.
- **Point Class** – return Tags with a particular Point Class or all Point Classes

The fields are ANDed together so selecting a particular Data Type and a particular Point Class will result in retrieving ONLY those Tags that have that Data Type AND the Point Class.

The “Max No of Tags” field allows the search results to be truncated. Any number greater than 0 may be entered in this field.
Attribute Retrieval Tab

These fields allow you to choose which attributes of the retrieved Tags to load into Spotfire and how many search results to return.

By default, the following Tag Attributes are always returned:

- **Tag Name** – the name of the Tag
- **Server** – the OSIsoft PI Server that the Tag was retrieved from

Attributes can be added to the Selected Attributes list by selecting one or more entries and clicking on the “Add” button (single arrow facing right). Similarly items can be removed from the Selected Attributes list by selecting one or more entries and clicking on the “Remove” button (single arrow facing left).

Individual entries can also be added or removed by double clicking and all entries can be added or removed by clicking on the “Add All” (double arrow facing right) or “Remove All” (double arrow facing left) buttons.

Data Validation

When the OK Button is pressed, data on the form is validated. In the event that a problem is found, a Red Exclamation Point will be placed next to the problem field. Click on this marker to see the description of the problem.
Some possible problems are:

- The Username is missing for PI Server Authentication
- The Password and/or Domain are missing for Windows Authentication
- The “Max No of Tags” field is less than 1

**Data Returned**
Spotfire will create a Data Table for the data returned by the Datasource. Depending upon your individual Spotfire settings, a Spotfire Table or other Visualization may be created, or the Recommendation dialog may appear.

The data columns returned are listed in Appendix A.

**Resizing**
The Configuration Dialog can be resized using the resize handle in the bottom right hand corner of the dialog. As the dialog is resized, the Available Attributes and Selected Attributes list boxes will resize automatically to fit. Additionally a slider control exists just to the right of the Add and Remove Attributes buttons to allow the width of the list boxes to be manually adjusted.

![Figure 18: Resizing the Configuration Dialog](image-url)
5. Retrieving OSIsoft PI Tag Data

Select the File → Open From → OSIsoft® PI™ Tag Data… menu item as shown:

Figure 19: Opening PI Tag Data from the Menu

Configuration Dialog

The configuration dialog allows you to choose a list of Tags to retrieve data for from the OSIsoft PI Server.

Figure 20: Tag Data Configuration Dialog

When first opened the dialog controls are disabled with the exception of the “Connection” tab and its controls. Once a connection to a PI Server has been successfully created the “Tag Selection” and “Data Retrieval” tabs, and their controls, become enabled.
Connection Tab

These controls allow you to choose how you will authenticate with the PI Server. There are 3 options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI Server*</td>
<td>In this mode you authenticate using a username and password setup directly on the PI Server. In this mode the domain option is not needed and is disabled.</td>
<td></td>
</tr>
<tr>
<td>Windows Explicit*</td>
<td>In this mode you authenticate using a Windows Domain account that has been configured on the PI Server to have access. You will need to enter the Windows Account Username, Password and Domain.</td>
<td></td>
</tr>
<tr>
<td>Windows Integrated</td>
<td>In this mode you authenticate using your current Window Domain Account (the one you are logged in as). In this mode, all credentials fields are disabled.</td>
<td></td>
</tr>
</tbody>
</table>

* - These options can be disabled to prevent the use of usernames and passwords. See “Spotfire Preferences” in Chapter 2 for more details.

After selecting the required connection mode and entering the required fields, press the “Connect…” button. If successful, the remaining dialog tabs and controls will be enabled. If the connection is unsuccessful, an error message will be displayed. For possible troubleshooting steps, see Appendix F.
Tag Selection Tag

These controls allow you to select one or more Tags to retrieve data for. Tags are added to the list by first searching for Tags on the PI Server and then adding one or more of the search results to the Tag List.

Data Retrieval Tab

These fields allow you to further control how data for the selected Tags is retrieved.

- **Retrieval Mode** – the PI Server that the Tag was retrieved from. There are multiple options:
  - **Actual Values** – returns only actual recorded data points. This mode can only be used with Tags that return numerical data.
  - **Interpolated Values** – returns data interpolated to produce the requested number of points. This mode can only be used with Tags that return numerical data.
  - **Plot Values** – returns data enhanced to look good on a chart plot.
  - **Snapshot** – returns the current Snapshot value of the Tag data.
  - **Total, Average, Minimum, Maximum, StdDev, PopulationStdDev, Count, PercentGood** – these options calculate values for each summary
period. The way that the values are calculated and the way the summary periods are aligned with the Start and End Times can be varied.

- **Calculation Basis** – when using one of the Calculated Methods above, this parameter alters the way the selected calculation is applied.

- **Timestamp Calculation** – when using one of the Calculated Methods above, this option determines how the Summary Duration periods line up with the Start and End Times.

- **Summary Duration** - when using one of the Calculated Methods above, this option determines the period of time for which the PI System will calculate values. The PI System indicates when there are no suitable data values within an individual Summary Duration period.

- **Number of Points** – the maximum number of data points to retrieve for any one Tag

- **Start Date/Time** – the start of the date/time range to retrieve data. For examples of valid formats see Appendix E.

- **End Date/Time** – the end of the date/time range to retrieve data. For examples of valid formats see Appendix E.

- **Timezone** – the timezone in which to return data value timestamps. Options are “UTC” for Co-ordinated Universal Time or “Local” for the timezone where the Spotfire client is running.

**Data Validation**

When the OK Button is pressed that data on the form will be validated. In the event that a problem is found, a Red Exclamation Point will be placed next to the problem field. Click on this marker to see the description of the problem.

![Example Validation Error - Missing Password](image-url)

Some possible problems are:

- The Username is missing for PI Server Authentication
- The Password and/or Domain are missing for Windows Authentication
• The Tag List is empty
• An invalid Start Date/Time has been entered
• An invalid End Date/Time has been entered
• The End Date/Time is earlier than the Start Date/Time
• The “Actual Values” or “Interpolated Values” Retrieval Mode has been selected and the Tag List contains one or more Tags that return data that is not numerical.

**Data Returned**

Spotfire will create a Data Table for the data returned by the Datasource. Depending upon your individual Spotfire settings, a Spotfire Table or other Visualization may be created, or the Recommendation dialog may appear.

The data columns returned are listed in Appendix A.

**Resizing**

The Configuration Dialog can be resized using the resize handle in the bottom right hand corner of the dialog. As the dialog is resized, the Tag List listbox will resize automatically to fit. Additionally a slider control exists just to the bottom of the Add and Remove Tag buttons to allow the height of the list boxes to be manually adjusted.

*Figure 25: Resizing the Configuration Dialog*
6. Retrieving OSIsoft PI Calculation Data

Select the File → Open From → OSIsoft® PI™ Calculation Data… menu item as shown:

![Figure 26: Opening PI Calculation Data from the Menu](image)

**Configuration Dialog**

The configuration dialog allows you to enter a Performance Expression to retrieve data from the OSIsoft PI Server.

![Figure 27: Tag Data Configuration Dialog](image)

When first opened the dialog controls are disabled with the exception of the “Connection” tab and its controls. Once a connection to a PI Server has been successfully created the “Tag Selection” and “Data Retrieval” tabs, and their controls, become enabled.

The functionality of the Calculations data source represents the methods of the OSIsoft AFCalculations class. For more detailed descriptions of functionality see the AF SDK Documentation.
Connection Tab

These controls allow you to choose how you will authenticate with the PI Server. There are 3 options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>PI Server*</td>
<td>In this mode you authenticate using a username and password setup directly on the PI Server. In this mode the domain option is not needed and is disabled.</td>
<td></td>
</tr>
<tr>
<td>Windows Explicit*</td>
<td>In this mode you authenticate using a Windows Domain account that has been configured on the PI Server to have access. You will need to enter the Windows Account Username, Password and Domain.</td>
<td></td>
</tr>
<tr>
<td>Windows Integrated</td>
<td>In this mode you authenticate using your current Windows Domain Account (the one you are logged in as). In this mode, all credentials fields are disabled.</td>
<td></td>
</tr>
</tbody>
</table>

Table 3 : Connection Options

* - These options can be disabled to prevent the use of usernames and passwords. See “Spotfire Preferences” in Chapter 2 for more details.

After selecting the required connection mode and entering the required fields, press the “Connect…” button. If successful, the remaining dialog tabs and controls will be enabled. If the connection is unsuccessful, an error message will be displayed. For possible troubleshooting steps, see Appendix F.
Data Retrieval Tab

The first three fields are common to all modes of operation.

- **Expression** – Any valid OSIsoft Performance Equation statement.
- **Include “No Sample” Values** – allows results that do not contain a value to be omitted from the results. This is typically used in conjunction with an “if” statement in the expression such as:

  ```
  if 'sinusoid' > 50 then 'sinusoid' else NoOutput()
  ```

Examples of Performance Equation syntax can be found [here](#).

- **Calculation Mode** – determines how the Performance Expression is to be evaluated. There are multiple options:
  - **Calculate At Intervals** – values are calculated at regularly spaced intervals between the Start Date/Time and End Time
  - **Calculate At Recorded Values** – values are calculated whenever actual data values exist between the Start Date/Time and End Time
  - **Calculate At Times** – values are calculated at specific Dates/Times
  - **Calculate Summaries** – many different calculations can be performed simultaneously over the selected Date/Time Range

The other fields display differently depending upon Calculation Mode selected.
**Calculate At Intervals**

In this mode, values are calculated at regularly spaced intervals between the Start Date/Time and End Time.

- **Sample Interval** – the time interval between samples. This can be expressed using OSIsoft `AFTimeSpan` syntax.
- **Start Date/Time** – the start of the date/time range to retrieve data. For examples of valid formats see Appendix E.
- **End Date/Time** – the end of the date/time range to retrieve data. For examples of valid formats see Appendix E.
- **Timezone** – the timezone in which to return data value timestamps. Options are “UTC” for Co-ordinated Universal Time or “Local” for the timezone where the Spotfire client is running.

**Calculate At Recorded Values**

![Figure 31: Calculate At Recorded Values Mode](image)
In this mode, values are calculated whenever actual data values exist between the Start Date/Time and End Time.

- **Start Date/Time** – the start of the date/time range to retrieve data. For examples of valid formats see Appendix E.
- **End Date/Time** – the end of the date/time range to retrieve data. For examples of valid formats see Appendix E.
- **Timezone** – the timezone in which to return data value timestamps. Options are “UTC” for Co-ordinated Universal Time or “Local” for the timezone where the Spotfire client is running.

### Calculate At Times

![Figure 32: Calculate At Times Mode](image)

In this mode, values are calculated for a set of specific Dates/Times.

- **Times** – a comma separated list of Dates/Times to retrieve data at. For examples of valid formats see Appendix E.
Calculate Summaries

In this mode, multiple calculations can be performed simultaneously:

- **Total** – The total value over the time range
- **Average** – The average value over the time range.
- **Minimum** – The minimum value over the time range.
- **Maximum** – The maximum value over the time range.
- **Range** – The range of values over the time range (Maximum-Minimum)
- **StdDev** – The standard deviation over the time range.
- **PopulationStdDev** – The population standard deviation over the time range.
- **Count** – The sum of event count over the time range when calculation basis is event weighted. The sum of event time duration over the time range when calculation basis is time weighted.
- **PercentGood** – Percent of data with good value during the calculation period. For time weighted calculations, the percentage is based on time. For event weighted calculations, the percent is based on event count.
- **TotalWithUOM** – A totalization over the time range with UOM assigned to the result if the input has units of measure defined. If the input does not have units of measure defined, this returns the same value as Total. If no valid units can be determined, this value will contain an error.

The rest of the fields work as follows:

- **Calculation Basis** – when using one of the Calculation Modes above, this parameter alters the way the selected calculation is applied.
- **Sample Type** – there are two possible values:
  - **Recorded Values** – calculations will be based on the timestamps of actual recorded values.
Intervals – calculations will be performed at regular time intervals.

- **Sample Interval** – determines the time between samples when **Sample Type** is selected as **Interval**.

- **Timestamp Calculation** – this option determines how the Summary Duration periods line up with the Start and End Times.

- **Summary Duration** - this option determines the period of time for which the PI System will calculate values. The PI System indicates when there are no suitable data values within an individual Summary Duration period.

- **Start Date/Time** – the start of the date/time range to retrieve data. For examples of valid formats see Appendix E.

- **End Date/Time** – the end of the date/time range to retrieve data. For examples of valid formats see Appendix E.

- **Timezone** – the timezone in which to return data value timestamps. Options are “UTC” for Co-ordinated Universal Time or “Local” for the timezone where the Spotfire client is running.

**Data Validation**

When the OK Button is pressed that data on the form will be validated. In the event that a problem is found, a Red Exclamation Point will be placed next to the problem field. Click on this marker to see the description of the problem.

![Figure 34: Example Validation Error - Missing Password](image)

Some possible problems are:

- The Username is missing for PI Server Authentication
- The Password and/or Domain are missing for Windows Authentication
- The Expression is empty
- An invalid Start Date/Time has been entered
- An invalid End Date/Time has been entered
- The End Date/Time is earlier than the Start Date/Time
Data Returned
Spotfire will create a Data Table for the data returned by the Datasource. Depending upon your individual Spotfire settings, a Spotfire Table or other Visualization may be created, or the Recommendation dialog may appear.

The data columns returned are listed in Appendix A.

Resizing
The Configuration Dialog cannot be resized.
7. Retrieving OSIsoft Asset Framework™ Metadata & Data

Select the File → Open From → OSIsoft® PI Asset Framework™… menu item as shown:

![Figure 35: Opening Asset Framework data from the Menu]

**Configuration Dialog**

The configuration dialog allows you to:

- Select one or more AF Elements including the Element Parents
- Select one or more AF Attributes
- Decide whether to retrieve Attribute Data Values

![Figure 36: Asset Framework Data Configuration Dialog]

When first opened the dialog controls are disabled with the exception of the “Connection” tab and its controls. Once a connection to a PI System has been successfully created the “Elements and Attributes” and “Data Retrieval” tabs, and their controls, become enabled and show any previously selected Elements and Attributes.
Connection Tab

These controls allow you to choose how you will authenticate with the PI System. There are 2 options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Explicit*</td>
<td>In this mode you authenticate using a Windows Domain account that has been configured on the PI System to have access. You will need to enter the Windows Account Username, Password and Domain.</td>
<td></td>
</tr>
<tr>
<td>Windows Integrated</td>
<td>In this mode you authenticate using your current Window Domain Account (the one you are logged in as). In this mode, all credentials fields are disabled.</td>
<td></td>
</tr>
</tbody>
</table>

Table 4: Connection Options

* - This option can be disabled to prevent the use of usernames and passwords. See “Spotfire Preferences” in Chapter 2 for more details.

After selecting the required connection mode and entering the required fields, press the “Connect…” button. If successful, the remaining dialog fields will be enabled. If the connection is unsuccessful, an error message will be displayed.

For possible troubleshooting steps, see Appendix F.

Elements and Attributes Tab

These controls allow you to select one or more AF Elements and add them to the selection list.
Highlight the required Element and click the “Down Arrow”

Clicking “OK” with just one or more Elements selected will return just the Metadata about those elements.

Appendix A lists the data returned in this mode of Operation.

**AF Attributes**

These controls allow you to select one or more AF Attributes from different AF Elements and add them to the selection list.

Highlight the required Attribute and click the “Down Arrow”

Selecting one or more Elements and one or more Attributes selected will check which Elements have an Attribute of the same Name (not ID) and return Metadata for the combined list of Attributes.
For example, selecting the Attribute “Height” from one Element and then “Weight” from another and then selecting 10 Elements will create a combined list of Attributes (up to the maximum possible 2 \times 10 = 20) and return the metadata for this combined list.

Appendix A lists the data returned in this mode of Operation.

**Data Retrieval Tab**

![Data Retrieval Tab](image)

With the “Retrieve Attribute Data” option un-checked, only metadata about the selected Elements and Attributes will be returned.

With the “Retrieve Attribute Data” option checked, the actual Data Values for each selected Attribute of each selected Element will be retrieved, according to the other options on the tab as follows:

- **Retrieval Mode** – how the data will be retrieved. There are 4 options:
  - **Actual Values** – returns only actual recorded data points. This mode can only be used with Tags that return numerical data.
  - **Interpolated Values** – returns data interpolated to produce the requested number of points. This mode can only be used with Tags that return numerical data.
  - **Plot Values** – returns data enhanced to look good on a chart plot.
  - **Snapshot** – returns the current Snapshot value of the Tag data.
  - **Total, Average, Minimum, Maximum, StdDev, PopulationStdDev, Count, PercentGood** – these options calculate values for each summary period. The way that the values are calculated and the way the summary periods are aligned with the Start and End Times can be varied.

- **Calculation Basis** – when using one of the Calculated Methods above, this parameter alters the way the selected calculation is applied.
• **Timestamp Calculation** – when using one of the Calculated Methods above, this option determines how the Summary Duration periods line up with the Start and End Times.

• **Summary Duration** - when using one of the Calculated Methods above, this option determines the period of time for which the PI System will calculate values. The PI System indicates when there are no suitable data values within an individual Summary Duration period.

• **Start Date/Time** – the start of the date/time range to retrieve data. For examples of valid formats see Appendix E.

• **End Date/Time** – the end of the date/time range to retrieve data. For examples of valid formats see Appendix E.

• **Timezone** – the timezone in which to return data value timestamps. Options are “UTC” for Co-ordinated Universal Time or “Local” for the timezone where the Spotfire client is running.

• **Number of Points** – the maximum number of data points to retrieve for any one Attribute

---

**Data Validation**

When the OK Button is pressed that data on the form will be validated. In the event that a problem is found, a Red Exclamation Point will be placed next to the problem field. Click on this marker to see the description of the problem.

*Figure 38: Example Validation Error - Missing Password*

Some possible problems are:

• The username or password fields are missing or invalid
• No Elements have been selected
• Data Retrieval has been checked but no Attributes have been selected
• An invalid Start Date/Time has been entered
• An invalid End Date/Time has been entered
• The End Date/Time is earlier than the Start Date/Time
• The “Actual Values” or “Interpolated Values” Retrieval Mode has been selected and the Attribute List contains one or more Tags that return data that is not numerical.
**Resizing**

The Configuration Dialog can be resized using the resize handle in the bottom right hand corner of the dialog. As the dialog is resized, the various controls will resize automatically to fit. Additionally two slider controls exist to allow the height and width of the controls to be manually adjusted.

![Figure 39: Resizing the Configuration Dialog](image-url)
8. Retrieving OSIsoft Event Frame Metadata & Data

Select the File → Open From → OSIsoft® PI Asset Framework™ Event Frames… menu item as shown:

![Figure 40: Opening Event Frame data from the Menu](image)

**Configuration Dialog**

The configuration dialog allows you to:

- Find and select one or more AF Event Frames
- Retrieve all Attributes for the selected Event Frames
- Decide whether to retrieve Attribute Data Values
- Optionally extend the Event Frame data retrieval period

When first opened the dialog controls are disabled with the exception of the “Connection Details” controls. Once a connection to a PI System has been successfully created the remaining dialog controls become enabled and show any previously selected Event Frames and Attributes.
**Connection Tab**

These controls allow you to choose how you will authenticate with the PI System. There are 2 options:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
<th>Image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Explicit*</td>
<td>In this mode you authenticate using a Windows Domain account that has been configured on the PI System to have access. You will need to enter the Windows Account Username, Password and Domain.</td>
<td><img src="image.png" alt="Authentication Window" /></td>
</tr>
<tr>
<td>Windows Integrated</td>
<td>In this mode you authenticate using your current Window Domain Account (the one you are logged in as). In this mode, all credentials fields are disabled.</td>
<td><img src="image.png" alt="Authentication Window" /></td>
</tr>
</tbody>
</table>

* - This option can be disabled to prevent the use of usernames and passwords. See “Spotfire Preferences” in Chapter 2 for more details.

After selecting the required connection mode and entering the required fields, press the “Connect…” button. If successful, the remaining dialog fields will be enabled. If the connection is unsuccessful, an error message will be displayed.

For possible troubleshooting steps, see Appendix F.

**AF Event Frames Tab**

These controls allow you to find and select one or more AF Event Frames and add them to the selection list.

Enter a search string in the search box, or click on the dropdown to specify more advanced search criteria, then click on the Search button and the results of the search will be displayed.
Clicking the “Down Arrow” will add the selected Event Frame to the list of items to be retrieved.

Clicking on the Down Arrow on the Criteria bar will expand the advanced search options. These allow searching by Template or other attribute in addition to specifying the date range for the search.
Data Retrieval

With the “Retrieve Attribute Data” option un-checked, only metadata about the selected Event Frames will be returned.

With the “Retrieve Attribute Data” option checked, actual Data Values for each Event Frame Attribute will be retrieved according to the other options on the tab as follows:

- **Retrieval Mode** – how the data will be retrieved. There are 4 options:
  - **Actual Values** – returns only actual recorded data points. This mode can only be used with Tags that return numerical data.
  - **Interpolated Values** – returns data interpolated to produce the requested number of points. This mode can only be used with Tags that return numerical data.
  - **Plot Values** – returns data enhanced to look good on a chart plot.
  - **Snapshot** – returns the current Snapshot value of the Tag data.

- **Extend Date/Time** – these options allow the start and end data retrieval settings for each individual Event Frame to be extended. By default the data will be retrieved for the time period defined in the Event Frame metadata.

- **Timezone** – the timezone in which to return data value timestamps. Options are “UTC” for Co-ordinated Universal Time or “Local” for the timezone where the Spotfire client is running.

- **Number of Points** – the maximum number of data points to retrieve for any one Event Frame Attribute

Appendix A lists the data returned for each mode of Operation.
Data Validation
When the OK Button is pressed that data on the form will be validated. In the event that a problem is found, a Red Exclamation Point will be placed next to the problem field. Click on this marker to see the description of the problem.

Some possible problems are:

- No Event Frames have been selected
- Data Retrieval has been checked but an invalid number of points has been selected
- The “Actual Values” or “Interpolated Values” Retrieval Mode has been selected and the Event Frame Attribute List contains one or more Tags that return data that is not numerical.

Resizing
The Configuration Dialog can be resized using the resize handle in the bottom right hand corner of the dialog. As the dialog is resized, the various controls will resize automatically to fit. Additionally a slider control exists to allow the relative height of the two list boxes to be adjusted.
9. Using the OSIsoft PI Tag List Data Function

In this configuration, the Tag List Datasource described previously is used to dynamically retrieve a list of Tag details based on Marking selections, Document Property changes etc.

Setup

There are two ways to create the Details View:

- Right-click on an active visualization and select “Create Tag List Details View…”. Typically this would be the visualization that you would Mark to drive the Tag List retrieval but that is not always the case.
- From the Tools menu, select “Create Tag List Details View…”. If there is not already an open DXP file, one will be created.

![Figure 48: Two ways to create a Tag List Visualization](image)

Edit Parameters Dialog

This dialog allows you to specify the source of each parameter to be supplied to the Tag List Datasource.
The following fields must be filled in:

- **Name** – this is a unique name that identifies the Data Function that will be created based on the parameter you enter. It will also be the name of the output Data Table that is created.

- **Refresh function Automatically** – if checked, then every time data within Spotfire changes that causes one or more of the Input Parameters to change then the Data Function will be executed and the Data Table contents replaced. If unchecked then the user will be alerted that a change is pending and will need to click on the Refresh icon to see the new data.

The Input Parameters are the same as those you entered on the Configuration Dialog in the previous section. Each parameter can be specified one of three ways:
• An expression – this expression can be a simple string or number or it can be a more complex expression created using the Spotfire Expression Editor. This allows for Document Properties to be specified as inputs.

• A Property Control selection set. This is a special expression that represent the item or items a user has highlighted in a Property Control within a Text Area

• A Column – in this case the Datasource will retrieve a data row for each item in this column. Typically the Tag Name would be specified using this method, but other parameters can also be specified in this way.

When a Column is chosen from the available columns in the DXP file, you can choose whether to use a Marking to limit the data retrieval to only Marked items or to return all items.

• None – the parameter will be empty

Making Configuration Changes
To make changes to the setup at a later time, use the “Edit” → “Data Function Properties” menu item to bring up the Data Function Properties dialog. From here, select the Data Function you created earlier and click on “Edit Parameters…”.

Example Use Cases
Some examples of how to use this functionality are:
• Driving Retrieval of a list of Tags from a Text Area that contains Property Controls that specify the Search criteria
  o Document Properties would be mapped to each Property Control in the Text Area
  o The Name Filter field would be an expression containing the value of the Document Property being controlled by the Search String Property Control
• The same principle can be applied to the “Search Descriptor”, “Point Source Filter”, “Data Type Filter”, “Point Class Filter”, “Attribute List” and “Num Points” fields
• Controlling Tag metadata retrieval based on choosing a set of Attribute names from a Multiple Selection Listbox Property Control
  o The Attribute List field would be an expression mapping the list of selected attributes to a comma-separated string - $AttributeList
  o The separator can be changed from comma to some other character if the names contain commas - "$map("${AttributeList}", ";")"
• Using the above configuration in conjunction with a Configuration Block to set the initial value of one or more document properties into a hyperlink that will open a visualization displaying a pre-defined list of Tags

http://localhost/SpotfireWeb/ViewAnalysis.aspx?file=/PITagSearch&configurationBlock=PITag%3DSINUSOID%3B

Where %3D is html code for “=” and %3B is html code for “;”. So this example opens the Analysis File “PITagSearch” and sets the Document Property “PITag” to “SINUSOID”.

Input Parameters
Appendix B lists the input parameter fields in greater detail and explains some special considerations required to understand how they drive behavior.
10. **Using the OSIsoft PI Tag Data Function**

In this configuration, the Tag Data Datasource described previously is used to dynamically retrieve Tag Data based on Marking selections, Document Property changes etc.

**Setup**

There are two ways to create the Details View:

- Right-click on an active visualization and select “Create Tag Data Details View…”. Typically this would be the visualization that you would Mark to drive the Tag List retrieval but that is not always the case.
- From the Tools menu, select “Create Tag Data Details View…”. If there is not already an open DXP file, one will be created.

![Figure 52: Two ways to create a Tag Data Details Visualization](image)

**Edit Parameters Dialog**

This dialog allows you to specify the source of each parameter to be supplied to the Tag Data Datasource.
The following fields must be filled in:

- **Name** – this is a unique name that identifies the Data Function that will be created based on the parameter you enter. It will also be the name of the output Data Table that is created.
- **Refresh function Automatically** – if checked, then every time data within Spotfire changes that causes one or more of the Input Parameters to change then the Data Function will be executed and the Data Table contents replaced. If unchecked then the user will be alerted that a change is pending and will need to click on the Refresh icon to see the new data.

The Input Parameters are the same as those you entered on the Configuration Dialog in the previous section. Each parameter can be specified one of three ways:

- **An expression** – this expression can be a simple string or number or it can be a more complex expression created using the Spotfire Expression Editor. This allows for Document Properties to be specified as inputs.
• A Property Control selection set. This is a special expression that represents the item or items a user has highlighted in a Property Control within a Text Area
• A Column – in this case the Datasource will retrieve a data row for each item in this column. Typically the Tag Name would be specified using this method, but other parameters can also be specified in this way.
When a Column is chosen from the available columns in the DXP file, you can choose whether to use a Marking to limit the data retrieval to only Marked items or to return all items.
• None – the parameter will be empty

Making Configuration Changes
To make changes to the setup at a later time, use the “Edit” -> “Data Function Properties” menu item to bring up the Data Function Properties dialog. From here, select the Data Function you created earlier and click on “Edit Parameters…”.

![Data Function Properties](image)

Figure 55: Making Changes to an existing Detail View

Example Use Cases
Some examples of how to use this drilldown functionality are:

• Driving data retrieval for one or more Tags based on Marking in a master visualization
• The Tag Name field would be specified as a Column and Limited By Marking
  • Driving data retrieval based on choosing a Tag name from a Property Control
    • The Tag name field would be an expression containing the value of the Document Property being controlled by the Property Control
  • Driving data retrieval based on choosing a set of Tag names from a Multiple Selection Listbox Property Control
    • The Tag name field would be an expression mapping the list of selected items to a comma-separated string - $TagList
    • The separator can be changed from comma to some other character if the names contain commas - "$map("${TagList}"", ",\"\")"
  • Driving data retrieval based on the Retrieval Method being selected from a Property Control
    • The Retrieval Mode field would be an expression containing the value of the Document Property being controlled by the Property Control
  • The same principle can be applied to the “Num Points”, “Start Time” and “End Time” fields

**Input Parameters**

Appendix B lists the input parameter fields in greater detail and explains some special considerations required to understand how they drive behavior.
11. **Using the OSIsoft Calculations Data Function**

In this configuration, the Calculations Datasource described previously is used to dynamically retrieve Tag Data based on an OSIsoft Performance Equation expression.

**Setup**

There are two ways to create the Details View:

- Right-click on an active visualization and select “Create Tag Data Details View…”. Typically this would be the visualization that you would Mark to drive the Tag List retrieval but that is not always the case.
- From the Tools menu, select “Create Tag Data Details View…”. If there is not already an open DXP file, one will be created.

![Figure 56: Two ways to create a Calculations Details Visualization](image)

**Edit Parameters Dialog**

This dialog allows you to specify the source of each parameter to be supplied to the Tag Data Datasource.
The following fields must be filled in:

- **Name** – this is a unique name that identifies the Data Function that will be created based on the parameter you enter. It will also be the name of the output Data Table that is created.
- **Refresh function Automatically** – if checked, then every time data within Spotfire changes that causes one or more of the Input Parameters to change then the Data Function will be executed and the Data Table contents replaced. If unchecked then the user will be alerted that a change is pending and will need to click on the Refresh icon to see the new data.

The Input Parameters are the same as those you entered on the Configuration Dialog in the previous section. Each parameter can be specified one of three ways:

- **An expression** – this expression can be a simple string or number or it can be a more complex expression created using the Spotfire Expression Editor. This allows for Document Properties to be specified as inputs.
• A Property Control selection set. This is a special expression that represent the item or items a user has highlighted in a Property Control within a Text Area
• A Column – in this case the Datasource will retrieve a data row for each item in this column. Typically the Tag Name would be specified using this method, but other parameters can also be specified in this way.
When a Column is chosen from the available columns in the DXP file, you can choose whether to use a Marking to limit the data retrieval to only Marked items or to return all items.
• None – the parameter will be empty

Making Configuration Changes
To make changes to the setup at a later time, use the “Edit”→”Data Function Properties” menu item to bring up the Data Function Properties dialog. From here, select the Data Function you created earlier and click on “Edit Parameters…”.

Example Use Cases
Some examples of how to use this drilldown functionality are:

• Driving data retrieval for one or more Tags based on Marking in a master visualization
  o The Tag Name field would be specified as a Column and Limited By Marking
• Driving data retrieval based on choosing a Tag name from a Property Control
• The Tag name field would be an expression containing the value of the Document Property being controlled by the Property Control

• Driving data retrieval based on choosing a set of Tag names from a Multiple Selection Listbox Property Control
  o The Tag name field would be an expression mapping the list of selected items to a comma-separated string - $TagList
  o The separator can be changed from comma to some other character if the names contain commas - "$map("${TagList}", ",\";\")"

• Driving data retrieval based on the Retrieval Method being selected from a Property Control
  o The Retrieval Mode field would be an expression containing the value of the Document Property being controlled by the Property Control

• The same principle can be applied to the “Num Points”, “Start Time” and “End Time” fields

Input Parameters
Appendix B lists the input parameter fields in greater detail and explains some special considerations required to understand how they drive behavior.
12. **Using the OSIsoft AF Attribute Data Function**

The Asset Framework Data Function allows the dynamic retrieval of Element metadata, Attribute metadata or Attribute Data based on Marking selections, Document Property changes etc.

**Modes**

The Data Function operates in different Modes, each taking different input parameters and producing different output data.

The following table describes the different Modes and their function:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Elements</td>
<td>Retrieves a list of Elements by Element ID</td>
</tr>
<tr>
<td>Attributes</td>
<td>Retrieves a list of Attributes by Element ID and Attribute Name</td>
</tr>
<tr>
<td>Data</td>
<td>Retrieves Attribute Data for a set of Element IDs and Attribute Names</td>
</tr>
<tr>
<td>Templates</td>
<td>Retrieves a list of defined AF Templates</td>
</tr>
<tr>
<td>ElementsByTemplate</td>
<td>Retrieves a list of Elements that are based on a given AF Template. Additional options include a starting Element, and whether to search all descendants.</td>
</tr>
<tr>
<td>Categories</td>
<td>Retrieves a list of defined AF Categories</td>
</tr>
<tr>
<td>ElementsByCategory</td>
<td>Retrieves a list of Elements that are in a given AF Category. Additional options include a starting Element, and whether to search all descendants.</td>
</tr>
</tbody>
</table>

*Table 6: Asset Framework Data Function Modes*

**Setup**

There are two ways to create the Details View:

- Right-click on an active visualization and select “Create Asset Framework Details View...”. Typically this would be the visualization that you would Mark to drive the Event Frame Data retrieval but that is not always the case.
- From the Tools menu, select “Create Asset Framework Details View...”. If there is not already an open DXP file, one will be created.
Edit Parameters Dialog
This dialog allows you to specify the source of each parameter to be supplied to the AF Data Datasource.

The following fields must be filled in:

- **Name** – this is a unique name that identifies the Data Function that will be created based on the parameter you enter. It will also be the name of the output Data Table that is created.
- **Refresh function Automatically** – if checked, then every time data within Spotfire changes that causes one or more of the Input Parameters to change then the Data Function will be executed and the Data Table contents replaced. If unchecked then the user will be alerted that a change is pending and will need to click on the Refresh icon to see the new data.
• Mode – This parameter tells the Data Function how you want to use it, what other parameters to look for and what data to return. Appendix C describes in detail the different Modes, what they do, and the Input Parameters required for each Mode.

Each Input parameter can be specified one of three ways:

• An expression – this expression can be a simple string or number or it can be a more complex expression created using the Spotfire Expression Editor. This allows for Document Properties to be specified as inputs.
• A Property Control selection set. This is a special expression that represent the item or items a user has highlighted in a Property Control within a Text Area
• A Column – in this case the Data Function will retrieve data for each item in this column. Typically the Element ID would be specified using this method, but other parameters can also be specified in this way.

When a Column is chosen from the available columns in the DXP file, you can choose whether to use a Marking to limit the data retrieval to only Marked items or to return all items.
• None – the parameter will be empty

Making Configuration Changes
To make changes to the setup at a later time, use the “Edit”→“Data Function Properties” menu item to bring up the Data Function Properties dialog. From here, select the Data Function you created earlier and click on “Edit Parameters…”. 
Example Use Cases
Some examples of how to use this drilldown functionality are:

- Driving Attribute Name retrieval for one or more Elements based on Marking in a master visualization
  - The Mode would be set to “Attributes”
  - The Element ID field would be specified as a Column and Limited By Marking
- Driving data retrieval based on choosing Elements and/or Attributes from Property Controls
  - The Mode would be set to “Data”
  - The Element ID and the Attribute Name fields would be expressions containing the value of Document Properties being controlled by the Property Controls
- Driving data retrieval based on choosing a set of Elements and/or Attributes from a Multiple Selection Listbox Property Control
  - The Element ID and/or Attribute Name field would be an expression mapping the list of selected items to a comma-separated string - $ElementList / $AttributeList
  - The separator can be changed from comma to some other character if the names contain commas - "$map("$AttributeList", ",")"
- Driving data retrieval based on the Retrieval Method being selected from a Property Control
• The Mode would be set to “Data”
  o The Retrieval Mode field would be an expression containing the value of the Document Property being controlled by the Property Control

• Retrieving a list of AF Templates
  o The Mode would be set to “Templates”

• Retrieving a list of AF Elements that are based on a given Template
  o The Mode would be set to “ElementsByTemplate”
  o The Starting Element would be set to “” to start searching at the Root Element of the AF Database
  o The Template Name would be set to the Template to search for

• The same principle can be applied to the “Num Points”, “Start Time” and “End Time” fields

**Input Parameters**

Appendix C lists the input parameter fields for each Mode of operation in detail and explains some special considerations required to understand how they drive behavior.
13. Using the OSIsoft AF Event Frame Data Function

The AF Event Frame Data Function allows the dynamic retrieval of Event Frame metadata, Attribute metadata or Attribute Data based on Marking selections, Document Property changes etc.

Modes

The Data Function operates in different Modes, each taking different input parameters and producing different output data.

The following table describes the different Modes and their function:

<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EventFrames</td>
<td>Retrieves a list of Event Frames by Event Frame ID</td>
</tr>
<tr>
<td>Attributes</td>
<td>Retrieves a list of Attributes by Event Frame ID and Attribute Name or ID</td>
</tr>
<tr>
<td>EventFramesAndAttributes</td>
<td>Combines that above two result sets into one</td>
</tr>
<tr>
<td>Data</td>
<td>Retrieves Attribute Data for a set of Event Frame IDs and Attribute Names or IDs</td>
</tr>
<tr>
<td>Templates</td>
<td>Retrieves a list of defined AF Event Frame Templates</td>
</tr>
<tr>
<td>EventFramesByTemplate</td>
<td>Retrieves a list of Event Frames that are based on a given AF Template. Additional options include a starting Event Frame, and whether to search all descendants.</td>
</tr>
<tr>
<td>TemplateAttributes</td>
<td>Retrieves a list of Attributes for a set of AF Template names.</td>
</tr>
<tr>
<td>Search</td>
<td>Retrieves a list of Event Frames using the AF search syntax.</td>
</tr>
</tbody>
</table>

Table 7: AF Event Frame Data Function Modes

Setup

There are two ways to create the Details View:

- Right-click on an active visualization and select “Create Event Frames Details View…”. Typically this would be the visualization that you would Mark to drive the Event Frame Data retrieval but that is not always the case.
- From the Tools menu, select “Create Event Frames Details View…”. If there is not already an open DXP file, one will be created.
Figure 64: Two ways to create an Event Frames Details Visualization

**Edit Parameters Dialog**
This dialog allows you to specify the source of each parameter to be supplied to the Event Frame Datasource.

The following fields must be filled in:

- **Name** – this is a unique name that identifies the Data Function that will be created based on the parameter you enter. It will also be the name of the output Data Table that is created.
- **Refresh function Automatically** – if checked, then every time data within Spotfire changes that causes one or more of the Input Parameters to change then the Data Function will be executed and the Data Table contents replaced. If unchecked then the user will be alerted that a change is pending and will need to click on the
Refresh icon to see the new data.

Figure 66: Refresh Icon indicating that updated data is available

The Input Parameters are the same as those you entered on the Configuration Dialog in the previous section. Each parameter can be specified one of three ways:

- An expression – this expression can be a simple string or number or it can be a more complex expression created using the Spotfire Expression Editor. This allows for Document Properties to be specified as inputs.
- A Property Control selection set. This is a special expression that represent the item or items a user has highlighted in a Property Control within a Text Area
- A Column – in this case the Datasource will retrieve a data row for each item in this column. Typically the Tag Name would be specified using this method, but other parameters can also be specified in this way.

When a Column is chosen from the available columns in the DXP file, you can choose whether to use a Marking to limit the data retrieval to only Marked items or to return all items.

- None – the parameter will be empty

Making Configuration Changes

To make changes to the setup at a later time, use the “Edit”→”Data Function Properties” menu item to bring up the Data Function Properties dialog. From here, select the Data Function you created earlier and click on “Edit Parameters…”.
Example Use Cases

Some examples of how to use this drilldown functionality are:

- Driving Attribute Value retrieval for one or more Event Frames based on Marking in a master visualization
  - The Event Frame ID field would be specified as a Column and Limited By Marking
- Driving data retrieval based on choosing a set of Event Frames from a Multiple Selection Listbox Property Control
  - The Event Frame ID field would be an expression mapping the list of selected items to a comma-separated string - $EventFrameList
  - The separator can be changed from comma to some other character if the names contain commas - "$map("${EventFrameList }", ",;\")"
- Driving data retrieval based on the Retrieval Method being selected from a Property Control
  - The Retrieval Mode field would be an expression containing the value of the Document Property being controlled by the Property Control
- The same principle can be applied to the “Num Points”, “Extend Start Time” and “Extend End Time” fields
Input Parameters
Appendix D lists the input parameter fields for each Mode of operation in detail and explains some special considerations required to understand how they drive behavior.
14. **Using the Password Encryption Tool**

This Tool allows you the creation of encrypted versions of OSIsoft passwords. These can be used within data functions when the Encrypted option is set to TRUE. This avoids the possibility of another Spotfire user being able to observe the original password either by viewing the inputs to the Data Function or observing the data lineage information for the Data Function.

To create encrypted passwords access the Password Encryption Tool using the Tools menu in Spotfire.

![Figure 68: Using the Password Encryption Tool](image.png)

1. Enter the password to be encrypted into the first text box.
2. Enter the password a second time into the second text box.
3. Press the “Encrypt” button to display the encrypted password.
4. Press the “Close and Copy to Clipboard” button to close the dialog. The encrypted password will be copied to the clipboard ready to be pasted into the Data Function parameter.

**Controlling Access via Licenses**

The menu item to access the Password Encryption Tool will only appear to users who have been granted the appropriate Spotfire License as described in the section “Spotfire Licenses” in Section 2.
15. **IronPython Scripting**

In addition to being able to add data sources and data functions manually via the Spotfire User Interface, it is also possible to use IronPython scripting.

In general, the process for each data source is the same:

1. Setup the required references
2. Create a data source object using a prompt model populated with the required settings
3. Add a new data table using the data source

### Spotfire and System References

In addition to the specific imports for each data source, one or more of the following Spotfire or System imports will be required:

```python
# # Import Spotfire objects required
# from Spotfire.Dxp.Data import DataSourcePromptMode
from Spotfire.Dxp.Data import DataSourceConnection
from Spotfire.Dxp.Data import DataRowReader
from Spotfire.Dxp.Data import DataTable
from Spotfire.Dxp.Data import DataMarkingSelection
from Spotfire.Dxp.Application import Page
from Spotfire.Dxp.Application.Visuals import TablePlot
from System.Collections.Generic import List
etc...
```

### Table Plot Creation Code

In each of the examples below, the following code is used to create a default Table Plot using the name of the Data Table:

```python
def createTablePlot( dataTableName ):

    tablePlot.Title = dataTableName
    tablePlot.Data.DataTableReference = Document.Data.Tables[dataTableName]
    tablePlot.Data.UseActiveFiltering = True
    # # Add all the data table columns
    # tablePlot.TableColumns.AddRange ( Document.Data.Tables[dataTableName].Columns )
    tablePlot.AutoAddNewColumns = True
    # # AutoConfigure the remaining settings
    # tablePlot.AutoConfigure ()
```
Tag List Data Source

The following section shows how to populate a data table with Tag List Data and create a Table visualization.

Required References

Before any of the custom data source objects can be used in an IronPython script, the required references must be setup:

```python
import clr
clr.AddReference("SpotfirePS.Framework.OSIPIDataSource, Version=1.0.0.0, \nCulture=neutral, PublicKeyToken=ef33e7f75d4ca16b")
clr.AddReference("SpotfirePS.Framework.OSIPIDataSourceForms, Version=1.0.0.0, \nCulture=neutral, PublicKeyToken=ef33e7f75d4ca16b")
#
# Import the required classes
#
from SpotfirePS.Framework.OSIPIDataSource.DataSource.TagList import DataSourcePromptModel
from SpotfirePS.Framework.OSIPIDataSource.DataSource.TagList import DataSourceImpl
```

Creating a Data Source Object

For retrieving a Tag List, the prompt model contains:

1. OSIsoft Server connection information
2. Various search options (default is *)
3. A list of attributes to retrieve
4. The maximum number of entries to retrieve

The following code shows an example set of options:

```python
# # Create new default Prompt Model
# pm = DataSourcePromptModel ()
# # Connection and Authentication Settings
# pm.Server = "piserver"
# pm.UserName = "pidemo"
# pm.Password = ""
# pm.Domain = ""
# pm.Authmode = "OSIPI"
# # Search Settings
# pm.FilterName="sin*"
# pm.FilterPointSource="*"
# pm.FilterDataType="*"
# pm.FilterPointClass="*"
```
pm.AttributeList = List[str]()
pm.AttributeList.Add( "creationdate" )
pm.AttributeList.Add( "descriptor" )
pm.NumPoints = 100
#
# Create Data Source
#
ds = DataSourceImpl( pm );

## Adding or Replacing the Data Table

The following code either adds a new data table or replaces an existing one and creates a default Table Plot:

```python
# Add or replace data table using data source
#
dataTableName = "Tag List Data"

if Document.Data.Tables.Contains(dataTableName):
    Document.Data.Tables[dataTableName].ReplaceData(ds)
else:
    Document.Data.Tables.Add(dataTableName, ds)

createTablePlot( dataTableName )
```
**Tag Data DataSource**

The following section shows how to populate a data table with Tag Data and create a default Table visualization.

**Required References**

Before any of the custom data source objects can be used in an IronPython script, the required references must be setup:

```python
import clr
clr.AddReference( "SpotfirePS.Framework.OSIPIDataSource, Version=1.0.0.0, \nCulture=neutral, PublicKeyToken=ef33e7f75d4ca16b" )
#
# Import the required classes
#
from SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData import DataSourcePromptModel
from SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData import DataSourceImpl
from SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData import OSIPIDataSourceTagLocator
from SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData import TimeRange
```

**Creating a Data Source Object**

For retrieving Tag Data, the prompt model contains:

1. A list of Tags to retrieve, each item in the list specifying OSIsoft Server connection information
2. The data retrieval parameters

The following code shows an example set of options:

```python
# # Create new default Prompt Model
# pm = DataSourcePromptModel ()
# # Tag Information
# Tag1 = OSIPIDataSourceTagLocator (  "piserver", # Server  "pidemo", # UserName  ",", # Password  ",", # Domain  "OSIPI", # Authmode  "sinusoid", # TagName  None # TimeRange )
# # Retrieval Settings
# pm.TagList = List[OSIPIDataSourceTagLocator] ()
pTagList.Add ( Tag1 );
pm.RetrievalMode = "Actual Values"
pm.StartTime = "*-24h"
pm.EndTime = "*"
pm.Timezone = "Local"
pm.NumPoints = 100
#```
Adding or Replacing the Data Table

The following code either adds a new data table or replaces an existing one and creates a default Table Plot:

```python
# Create Data Source
#
# ds = DataSourceImpl ( pm );

# Add or replace data table using data source
#
dataTableName = "Tag Data"

if Document.Data.Tables.Contains(dataTableName):
    Document.Data.Tables[dataTableName].ReplaceData(ds)
else:
    Document.Data.Tables.Add(dataTableName, ds)

createTablePlot ( dataTableName )
```
Calculations DataSource

The following section shows how to populate a data table from an OSIsoft Performance Equation and create a default Table visualization.

Required References

Before any of the custom data source objects can be used in an IronPython script, the required references must be setup:

```python
import clr
clr.AddReference( "SpotfirePS.Framework.OSIPIDataSource, Version=1.0.0.0, Culture=neutral, PublicKeyToken=ef33e7f75d4ca16b" )

# Import the required classes
from SpotfirePS.Framework.OSIPIDataSource.DataSource.Calculation import DataSourcePromptModel
from SpotfirePS.Framework.OSIPIDataSource.DataSource.Calculation import DataSourceImpl
from SpotfirePS.Framework.OSIPIDataSource.DataSource.Calculation import OSIPIConnectionDetails
from SpotfirePS.Framework.OSIPIDataSource.DataSource.Calculation import OSIPICalculationDetails
```

Creating a Data Source Object

For retrieving Calculation Data, the prompt model contains a list of OSIPICalculationDetails objects, each of which contains:

1. An OSIPIConnectionDetails object which specifies the OSIsoft Server connection information
2. The data retrieval parameters

The following code shows an example set of options:

```python
# Create new default Prompt Model
pm = DataSourcePromptModel()

# Connection Information
Conn = OSIPIConnectionDetails()
Conn.Server = "piserver"
Conn.UserName = "pidemo"
Conn.Password = ""
Conn.Domain = ""
Conn.Authmode = "OSIPI"

# Calculation Information
Calc = OSIPICalculationDetails()
Calc.Connection = Conn
Calc.CalculationMode = "At Recorded Values"
Calc.Expression = "if 'sinusoid' > 50 then 'sinusoid' else NoOutput()"
Calc.IncludeNoSampleValues = False
Calc.StartTime = "*-24h"
Calc.EndTime = "*"
```
Calc.Timezone = "Local"
Calc.NumPoints = 100
#
# Unused Parameters for this Calculation Mode
#
Calc.SummaryDuration = ""
Calc.SummaryType = ""
Calc.CalculationBasis = ""
Calc.SampleType = ""
Calc.SampleInterval = ""
Calc.TimestampCalculation = ""
Calc.SampleTimes = List[str] ()
Calc.Comments = ""
#
# Retrieval Settings
#
pm.Calculations = List[OSIPICalculationDetails]()
pm.Calculations.Add ( Calc )
#
# Create Data Source
#
ds = DataSourceImpl ( pm );

**Adding or Replacing the Data Table**
The following code either adds a new data table or replaces an existing one and creates a default Table Plot:

# # Add or replace data table using data source
#
dataTableName = "Calculations Data"
if Document.Data.Tables.Contains(dataTableName):
    Document.Data.Tables[dataTableName].ReplaceData(ds)
else:
    Document.Data.Tables.Add(dataTableName, ds)
createTablePlot ( dataTableName )
Asset Framework DataSource

The following section shows how to populate a data table with Asset Framework Element data and create a default Table visualization.

Required References

Before any of the custom data source objects can be used in an IronPython script, the required references must be setup:

```python
import clr
clr.AddReference("SpotfirePS.Framework.OSIAFDataSource, Version=1.0.0.0, \
Culture=neutral, PublicKeyToken=ef33e7f75d4ca16b")
#
# Import the required classes
#
from SpotfirePS.Framework.OSIAFDataSource.DataSource import DataSourcePromptModel
from SpotfirePS.Framework.OSIAFDataSource.DataSource import DataSourceImpl
from SpotfirePS.Framework.OSIAFDataSource.DataSource import OSIAFDataSourceElementLocator
from SpotfirePS.Framework.OSIAFDataSource.DataSource import OSIAFDataSourceElementDetails
from SpotfirePS.Framework.OSIAFDataSource.DataSource import OSIAFDataSourceAttributeDetails
```

Creating a Data Source Object

For retrieving Asset Framework Element Data, the prompt model contains:

1. A list of OSIAFDataSourceElementLocator objects each of which contain:
   a. OSIsoft System connection information
   b. An OSIAFDataSourceElementDetails object
2. A list of OSIAFDataSourceAttributeDetails objects
3. The data retrieval parameters

The following code shows an example set of options:

```python
# # # Create new default Prompt Model
# pm = DataSourcePromptModel ()
# # Element Details
# ElementDetails1 = OSIAFDataSourceElementDetails ( 
"B-210", # Name
"0d9b0cdb-6aeb-11e6-8141-0259ceed5f1", # ID
"", # Parent
"", # Parent ID
)
# # Attribute Details
# AttributeDetails1 = OSIAFDataSourceAttributeDetails ( 
"Fuel Gas Flow", # Name
"6f6a3afa-bdce-5620-3213-02ab59702b25", # ID
"", # Parent
"", # Parent ID
)```
"0d9b0cdb-6aeb-11e6-8141-0259cee0cdf1", # Element ID
)
#
# Time Range
#
TimeRange1 = TimeRange (  
   "-24h", # StartTime  
   ",",   # EndTime  
   "",   # Comments
)
#
# Element Locator
#
ElementLocator1 = OSIADatasourceElementLocator (  
   "PISYSTEM", # System  
   "TEST", # Database  
   ",", # UserName  
   ",", # Password  
   ",", # Domain  
   ElementDetails1, # Element Details  
   TimeRange1 # TimeRange
)
#
# Retrieval Settings
#
pm.ElementList = List[OSIAFDatasourceElementLocator]()  
pm.ElementList.Add ( ElementLocator1 );  
pm.AttributeList = List[OSIAFDatasourceAttributeDetails]()  
pm.AttributeList.Add ( AttributeDetails1 );  

pm.RetrieveAttributeData = True  
pm.RetrievalMode = "Actual Values"  
pm.StartTime = "*-24h"  
pm.EndTime = "*"  
pm.Timezone = "Local"  
pm.NumPoints = 100  
#
# Unused Parameters in this Retrieval Mode
#
# pm.CalculationBasis = ""
# pm.TimestampCalculation = ""
# pm.SummaryDuration = ""
#
# Create Data Source
#
ds = DataSourceImpl ( pm );

**Adding or Replacing the Data Table**

The following code either adds a new data table or replaces an existing one and creates a default Table Plot:

```
# # Add or replace data table using data source
#
dataTableName = "Asset Framework Data"

if Document.Data.Tables.Contains(dataTableName):
   Document.Data.Tables[tableName].ReplaceData(ds)
else:
   Document.Data.Tables.Add(dataTableName, ds)

createTablePlot ( dataTableName )
```
Event Frame DataSource
The following section shows how to populate a data table with Asset Framework Event Frame data and create a default Table visualization.

Required References
Before any of the custom data source objects can be used in an IronPython script, the required references must be setup:

```python
import clr
clr.AddReference("SpotfirePS.Framework.OSIAFDataSource, Version=1.0.0.0, \nCulture=neutral, PublicKeyToken=ef33e7f75d4ca16b")
#
# Import the required classes
#
from SpotfirePS.Framework.OSIAFDataSource.EFDataSource import DataSourcePromptModel
from SpotfirePS.Framework.OSIAFDataSource.EFDataSource import DataSourceImpl
from SpotfirePS.Framework.OSIAFDataSource.EFDataSource import OSI.AFDataSourceEventFrameDetails
from SpotfirePS.Framework.OSIAFDataSource.EFDataSource import OSI.AFDataSourceEventFrameLocator
from SpotfirePS.Framework.OSIAFDataSource.EFDataSource import OSI.AFDataSourceAttributeDetails
```

Creating a Data Source Object
For retrieving Asset Framework Event Frame Data, the prompt model contains:

1. A list of OSI.AFDataSourceEventFrameLocator objects each of which contain:
   a. OSIsoft System connection information
   b. An OSI.AFDataSourceEventFrameDetails object
2. A list of OSI.AFDataSourceAttributeDetails objects
3. The data retrieval parameters

The following code shows an example set of options:

```python
# # Create new default Prompt Model
# pm = DataSourcePromptModel()
# # Event Frame Details
# EventFrameDetails1 = OSI.AFDataSourceEventFrameDetails(
#     "Test Event Frame1", # Name
#     "fcb777ab-e933-4c59-0000-000000000001", # ID
#     "", # Parent
#     "", # Parent ID
# )
# # Attribute Details
# AttributeDetails1 = OSI.AFDataSourceAttributeDetails(
#     "", # Name
#     "", # ID
#     "", # Parent
#     "", # Parent ID
#     "", # Element ID
```
Adding or Replacing the Data Table

The following code either adds a new data table or replaces an existing one and creates a default Table Plot:

```python
# Add or replace data table using data source
#
dataTableName = "Event Frame Data"

if Document.Data.Tables.Contains(dataTableName):
    Document.Data.Tables[dataTableName].ReplaceData(ds)
else:
    Document.Data.Tables.Add(dataTableName, ds)
createTablePlot(dataTableName)
```
16. Security Setup for Web Player and Automation Services

When accessing data from within Spotfire Analyst, most organizations have a default OSIsoft PI and AF security setup that identifies desktop users and provides them access to the appropriate data.

However, when using the data source within Web Player or Automation Services, the programs that run on the server do not run under a user account. Typically they run under a special Service Account that has limited privileges. Under these circumstances it is likely that a connection to a PI Server or PI System will fail without additional configuration.

The following sections detail some options that are available. Each of these is listed without merit. It is up to the user to choose the most appropriate choice for their particular requirements or security setup.

Using Explicit Username / Password Authentication

Rather than rely on Windows Integrated Authentication, this option allows the username and password to be specified explicitly. The account specified must still have the permissions needed to access the PI Server or PI System.

To avoid passwords being stored in plain text, the Password Encryption tool can be used to specify the password in encrypted form.

Perform Additional Setup Actions

In order to enable connections from Web Player or Automation Services, the following steps are typically required.

**NOTE:** The following steps are typical recommendations. It is not possible to prescribe exact steps for every possible OSIsoft security configuration.

1) Run the Spotfire Node Manager as a Windows Domain User

By default, the Spotfire Node Manager runs as the “Local System” user which has very limited privileges. Unless specifically enabled by the PI Administrator, a connection using this user will most likely fail.

The Node Manager Service should be configure to run under a Service Account. Typically this Service Account is a Windows Domain member.
To change the user account, access the properties of the “TIBCO Spotfire Node Manager <version>” service and select the “Log On” tab:

![Changing the User Account for the Node Manager Service](image_url)

**Figure 69 : Changing the User Account for the Node Manager Service**

### 2) Setup a PI Trust

The PI Server provides a rich combination of methods to setup a Trust that include:

- User / Group
- IP Address
- Executable Name

When setting up a PI Trust, there are various options for restricting the use of the Trust including specifying the application name. If this option is used, the application name (which represents the Spotfire Node Manager) should be specified as “Spotfire.Dxp.Worker.Host.exe”.

In the example shown below, the PI Trust will mean that analysis files opened in Web Player or Automation Services can access PI with the privileges of the “piusers” group.
For more information on setting up Trusts, consult the OSIsoft PI Server documentation.
Appendix A - Data Columns Retrieved

The following sections detail the columns of data retrieved for each Datasource and mode of operation.

PI Tag List

A row of data is retrieved for each PI Tag. The following columns are created by default and additional columns of data type String will be created for each Tag Attribute in the Selected Attributes list.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag Name</td>
<td>String</td>
<td>The Name of the Tag</td>
</tr>
<tr>
<td>Server</td>
<td>String</td>
<td>The OSIsoft PI Server the Tag was retrieved from</td>
</tr>
</tbody>
</table>

PI Tag Data

A row of data is retrieved for each Value at a certain point in time for each PI Tag.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>String</td>
<td>The OSIsoft PI Server the Tag was retrieved from.</td>
</tr>
<tr>
<td>Tag Name</td>
<td>String</td>
<td>The Name of the Tag.</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>String</td>
<td>The Retrieval Mode used.</td>
</tr>
<tr>
<td>Numeric Value</td>
<td>SingleReal</td>
<td>The numeric value of this data point. Null if this data point is invalid or Not A Number.</td>
</tr>
<tr>
<td>Text Value</td>
<td>String</td>
<td>The text value of the data point. In some cases, can contain error messages.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>DateTime</td>
<td>The time that this data point represents.</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” if the above Timestamp is displayed in Local Time or “UTC” if the Timestamp is displayed in UTC Time.</td>
</tr>
<tr>
<td>Status</td>
<td>String</td>
<td>The Status of the data point. For a list of values see the OSIsoft AFValueStatus documentation.</td>
</tr>
<tr>
<td>IsGood</td>
<td>String</td>
<td>False if the data is bad else True if the data is good or questionable.</td>
</tr>
<tr>
<td>Start Time</td>
<td>String</td>
<td>The Start Time setting used to retrieve this data point</td>
</tr>
<tr>
<td>End Time</td>
<td>String</td>
<td>The End Time setting used to retrieve this data point</td>
</tr>
<tr>
<td>Comments</td>
<td>String</td>
<td>The Comments parameter used when retrieving this data point. This column will only be populated when created via a Data Function or Details View.</td>
</tr>
</tbody>
</table>
Calculations Data
The data set represents the result of evaluating the OSIsoft Performance Equation expression.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>String</td>
<td>The OSIsoft PI Server the Tag was retrieved from.</td>
</tr>
<tr>
<td>Calculation Mode</td>
<td>String</td>
<td>The Calculation Mode used.</td>
</tr>
<tr>
<td>Numeric Value</td>
<td>SingleReal</td>
<td>The numeric value of this data point. Null if this data point is invalid or Not A Number.</td>
</tr>
<tr>
<td>Text Value</td>
<td>String</td>
<td>The text value of the data point. In some cases, can contain error messages.</td>
</tr>
<tr>
<td>Timestamp</td>
<td>DateTime</td>
<td>The time that this data point represents.</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” if the above Timestamp is displayed in Local Time or “UTC” if the Timestamp is displayed in UTC Time.</td>
</tr>
<tr>
<td>Status</td>
<td>String</td>
<td>The Status of the data point. For a list of values see the OSIsoft AFValueStatus documentation.</td>
</tr>
<tr>
<td>IsGood</td>
<td>String</td>
<td>False if the data is bad else True if the data is good or questionable.</td>
</tr>
<tr>
<td>Start Time</td>
<td>String</td>
<td>The Start Time setting used to retrieve this data point</td>
</tr>
<tr>
<td>End Time</td>
<td>String</td>
<td>The End Time setting used to retrieve this data point</td>
</tr>
<tr>
<td>Comments</td>
<td>String</td>
<td>The Comments parameter used when retrieving this data point. This column will only be populated when created via a Data Function or Details View.</td>
</tr>
</tbody>
</table>

AF Element Metadata
A row of data is retrieved for each AF Element including Parent Elements.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Name</td>
<td>String</td>
<td>The Name of the AF Element</td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Element</td>
</tr>
<tr>
<td>Element Categories</td>
<td>String</td>
<td>A semi-colon delimited list of the AF Element’s Categories</td>
</tr>
<tr>
<td>Element Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Element</td>
</tr>
<tr>
<td>Element Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Element</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>The Description of the Element in AF</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>The Type of the Element in AF</td>
</tr>
<tr>
<td>Template</td>
<td>String</td>
<td>The Template of the Element in AF</td>
</tr>
<tr>
<td>System</td>
<td>String</td>
<td>The PI System of the Element</td>
</tr>
<tr>
<td>Column Name</td>
<td>Spotfire Data Type</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database of the Element</td>
</tr>
<tr>
<td>Path</td>
<td>String</td>
<td>A path string describing the hierarchy to this Element from the owning Database</td>
</tr>
</tbody>
</table>

**AF Attribute Metadata**

A row of data is retrieved for each AF Attribute.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Name</td>
<td>String</td>
<td>The Name of the AF Element containing this Attribute</td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Element</td>
</tr>
<tr>
<td>Element Categories</td>
<td>String</td>
<td>A semi-colon delimited list of the AF Element’s Categories</td>
</tr>
<tr>
<td>Element Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Element</td>
</tr>
<tr>
<td>Element Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Element</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>The Name of the AF Attribute</td>
</tr>
<tr>
<td>Attribute ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Attribute</td>
</tr>
<tr>
<td>Attribute Categories</td>
<td>String</td>
<td>A semi-colon delimited list of the AF Attribute’s Categories</td>
</tr>
<tr>
<td>Attribute Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Attribute</td>
</tr>
<tr>
<td>Attribute Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Attribute</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>The Description of this AF Attribute</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>The Type of this AF Attribute</td>
</tr>
<tr>
<td>UOM</td>
<td>String</td>
<td>The Unit Of Measure of this AF Attribute</td>
</tr>
<tr>
<td>UOM Abbr</td>
<td>String</td>
<td>The Abbreviation of the Unit Of Measure of this AF Attribute</td>
</tr>
<tr>
<td>PI Tag</td>
<td>String</td>
<td>The PI Tag associated with this AF Attribute</td>
</tr>
<tr>
<td>System</td>
<td>String</td>
<td>The PI System of the AF Attribute</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database of the AF Attribute</td>
</tr>
<tr>
<td>Path</td>
<td>String</td>
<td>A path string describing the hierarchy to this Attribute from the owning Database through the Element Hierarchy</td>
</tr>
</tbody>
</table>
# AF Attribute Data

A row of data is retrieved for each Value at a certain point in time for each AF Attribute.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Element Name</td>
<td>String</td>
<td>The Name of the AF Element containing this Attribute</td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Element</td>
</tr>
<tr>
<td>Element Categories</td>
<td>String</td>
<td>A semi-colon delimited list of the AF Element’s Categories</td>
</tr>
<tr>
<td>Element Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Element</td>
</tr>
<tr>
<td>Element Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Element</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>The Name of the AF Attribute</td>
</tr>
<tr>
<td>Attribute ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Attribute</td>
</tr>
<tr>
<td>Attribute Categories</td>
<td>String</td>
<td>A semi-colon delimited list of the AF Attribute’s Categories</td>
</tr>
<tr>
<td>Attribute Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Attribute</td>
</tr>
<tr>
<td>Attribute Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Attribute</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>String</td>
<td>“Actual Values”, “Interpolated Values”, “Plot Values” or “Snapshot”</td>
</tr>
<tr>
<td>Numeric Value</td>
<td>SingleReal</td>
<td>If the Value retrieved is a Number then this field will be populated</td>
</tr>
<tr>
<td>Text Value</td>
<td>String</td>
<td>The Textual representation of the Tag Value. Null if the Status is Bad</td>
</tr>
<tr>
<td>Timestamp</td>
<td>DateTime</td>
<td>The UTC Timestamp for this Data Value</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” if the above Timestamp is displayed in Local Time or “UTC” if the Timestamp is displayed in UTC Time.</td>
</tr>
<tr>
<td>Status</td>
<td>String</td>
<td>Good or Bad</td>
</tr>
<tr>
<td>IsGood</td>
<td>String</td>
<td>“True” if status is Good, else “False”</td>
</tr>
<tr>
<td>Comments</td>
<td>String</td>
<td>The Comments parameter used when retrieving this data point. This column will only be populated when created via a Data Function or Details View.</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>The Description of the Attribute in AF</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>The Type of the Attribute in AF</td>
</tr>
<tr>
<td>UOM</td>
<td>String</td>
<td>The Unit Of Measure of this AF Attribute</td>
</tr>
<tr>
<td>UOM Abbr</td>
<td>String</td>
<td>The Abbreviation of the Unit of Measure of this AF Attribute</td>
</tr>
<tr>
<td>PI Tag</td>
<td>String</td>
<td>The PI Tag associated with this Attribute</td>
</tr>
<tr>
<td>System</td>
<td>String</td>
<td>The PI System of the Attribute</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database of the Attribute</td>
</tr>
<tr>
<td>Path</td>
<td>String</td>
<td>A path string describing the hierarchy to this Attribute from the owning Database through the Element Hierarchy</td>
</tr>
</tbody>
</table>
### AF Template Metadata
A row of data is retrieved for each AF Template.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>String</td>
<td>The Name of the AF Template</td>
</tr>
<tr>
<td>Template ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Template</td>
</tr>
</tbody>
</table>

### AF Category Metadata
A row of data is retrieved for each AF Category.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category Name</td>
<td>String</td>
<td>The Name of the AF Category</td>
</tr>
<tr>
<td>Category ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Category</td>
</tr>
</tbody>
</table>

### AF Event Frame Metadata
A row of data is retrieved for each AF Event Frame.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Frame Name</td>
<td>String</td>
<td>The Name of this Event Frame</td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>The ID (GUID) of this Event Frame</td>
</tr>
<tr>
<td>Event Frame Description</td>
<td>String</td>
<td>The Description of this Event Frame</td>
</tr>
<tr>
<td>Event Frame Template</td>
<td>String</td>
<td>The Name of the Template used to create this Event Frame</td>
</tr>
<tr>
<td>Event Frame Parent Name</td>
<td>String</td>
<td>The Name of the parent Event Frame</td>
</tr>
<tr>
<td>Event Frame Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the parent Event Frame</td>
</tr>
<tr>
<td>Start Time</td>
<td>DateTime</td>
<td>The Start Time defined for this Event Frame</td>
</tr>
<tr>
<td>End Time</td>
<td>DateTime</td>
<td>The End Time defined for this Event Frame</td>
</tr>
<tr>
<td>System</td>
<td>String</td>
<td>The PI System of the Attribute</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database of the Attribute</td>
</tr>
<tr>
<td>Path</td>
<td>String</td>
<td>A path string describing the hierarchy to this Event Frame from the owning Database through the Event Frame Hierarchy</td>
</tr>
</tbody>
</table>
AF Event Frame Attribute Metadata
A row of data is retrieved for each AF Attribute of the selected AF Event Frames.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Frame Name</td>
<td>String</td>
<td>The Name of the AF Event Frame containing this Attribute</td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Event Frame</td>
</tr>
<tr>
<td>Event Frame Description</td>
<td>String</td>
<td>The Description of this Event Frame</td>
</tr>
<tr>
<td>Event Frame Template</td>
<td>String</td>
<td>The Name of the Template used to create this Event Frame</td>
</tr>
<tr>
<td>Event Frame Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Event Frame</td>
</tr>
<tr>
<td>Event Frame Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Frame</td>
</tr>
<tr>
<td>Start Time</td>
<td>DateTime</td>
<td>The Start Time defined for this Event Frame</td>
</tr>
<tr>
<td>End Time</td>
<td>DateTime</td>
<td>The End Time defined for this Event Frame</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>The Name of the AF Attribute</td>
</tr>
<tr>
<td>Attribute ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Attribute</td>
</tr>
<tr>
<td>Attribute Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Attribute</td>
</tr>
<tr>
<td>Attribute Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Attribute</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>The Description of the Attribute in AF</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>The Type of the Attribute in AF</td>
</tr>
<tr>
<td>PI Tag</td>
<td>String</td>
<td>The PI Tag associated with this Attribute</td>
</tr>
<tr>
<td>System</td>
<td>String</td>
<td>The PI System of the Attribute</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database of the Attribute</td>
</tr>
<tr>
<td>Path</td>
<td>String</td>
<td>A path string describing the hierarchy to this Event Frame from the owning Database through the Event Frame Hierarchy</td>
</tr>
</tbody>
</table>
AF Event Frame Template Metadata
A row of data is retrieved for each Event Frame Template.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>String</td>
<td>The Name of the Event Frame Template</td>
</tr>
<tr>
<td>Template ID</td>
<td>String</td>
<td>The ID (GUID) of the Event Frame Template</td>
</tr>
</tbody>
</table>

AF Event Frame Template Attributes Metadata
A row of data is retrieved for each Attribute in an Event Frame Template.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Template Name</td>
<td>String</td>
<td>The Name of the Event Frame Template</td>
</tr>
<tr>
<td>Template ID</td>
<td>String</td>
<td>The ID (GUID) of the Event Frame Template</td>
</tr>
<tr>
<td>Attribute Template Name</td>
<td>String</td>
<td>The Name of this AF Attribute</td>
</tr>
<tr>
<td>Attribute Template ID</td>
<td>String</td>
<td>The ID (GUID) of this AF Attribute</td>
</tr>
</tbody>
</table>
**AF Event Frame Attribute Data**

A row of data is retrieved for each Value at a certain point in time for each AF Attribute.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Frame Name</td>
<td>String</td>
<td>The Name of the AF Event Frame containing this Attribute</td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Event Frame</td>
</tr>
<tr>
<td>Event Frame Description</td>
<td>String</td>
<td>The Description of this Event Frame</td>
</tr>
<tr>
<td>Event Frame Template</td>
<td>String</td>
<td>The Name of the Template used to create this Event Frame</td>
</tr>
<tr>
<td>Event Frame Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Event Frame</td>
</tr>
<tr>
<td>Event Frame Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Event Frame</td>
</tr>
<tr>
<td>Start Time</td>
<td>DateTime</td>
<td>The Start Time defined for this Event Frame</td>
</tr>
<tr>
<td>End Time</td>
<td>DateTime</td>
<td>The End Time defined for this Event Frame</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>The Name of the AF Attribute</td>
</tr>
<tr>
<td>Attribute ID</td>
<td>String</td>
<td>The ID (GUID) of the AF Attribute</td>
</tr>
<tr>
<td>Attribute Parent Name</td>
<td>String</td>
<td>The Name of the Parent AF Attribute</td>
</tr>
<tr>
<td>Attribute Parent ID</td>
<td>String</td>
<td>The ID (GUID) of the Parent AF Attribute</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>String</td>
<td>“Actual Values”, “Interpolated Values”, “Plot Values” or “Snapshot”</td>
</tr>
<tr>
<td>Numeric Value</td>
<td>SingleReal</td>
<td>If the Value retrieved is a Number then this field will be populated</td>
</tr>
<tr>
<td>Text Value</td>
<td>String</td>
<td>The Textual representation of the Tag Value. Null if the Status is Bad</td>
</tr>
<tr>
<td>Timestamp</td>
<td>DateTime</td>
<td>The UTC Timestamp for this Data Value</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” if the above Timestamp is displayed in Local Time or “UTC” if the Timestamp is displayed in UTC Time.</td>
</tr>
<tr>
<td>Status</td>
<td>String</td>
<td>Good or Bad</td>
</tr>
<tr>
<td>IsGood</td>
<td>String</td>
<td>“True” if status is Good, else “False”</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>The Description of the Attribute in AF</td>
</tr>
<tr>
<td>Type</td>
<td>String</td>
<td>The Type of the Attribute in AF</td>
</tr>
<tr>
<td>UOM</td>
<td>String</td>
<td>The Unit Of Measure of the Attribute in AF</td>
</tr>
<tr>
<td>PI Tag</td>
<td>String</td>
<td>The PI Tag associated with this Attribute</td>
</tr>
<tr>
<td>System</td>
<td>String</td>
<td>The PI System of the Attribute</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database of the Attribute</td>
</tr>
<tr>
<td>Path</td>
<td>String</td>
<td>A path string describing the hierarchy to this Attribute from the owning Database through the Event Frame Hierarchy</td>
</tr>
</tbody>
</table>

Custom Datasource for OSIsoft® PI System®
Appendix B – PI Data Function Input Parameters

The following sections detail the Input Parameters used by each Data Function and how they drive behavior.

PI Tag List

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>String</td>
<td>The OSIsoft PI Server to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use</td>
<td>#1</td>
</tr>
<tr>
<td>Authmode</td>
<td>String</td>
<td>The Authentication Mode to use</td>
<td>#1</td>
</tr>
<tr>
<td>Name Filter</td>
<td>String</td>
<td>The Tag Name Filter string. Asterisk * is a wildcard.</td>
<td></td>
</tr>
<tr>
<td>Search Descriptor</td>
<td>Boolean</td>
<td>“True” to search the Descriptor as well as the Tag Name, “False” to just search the Tag Name.</td>
<td></td>
</tr>
<tr>
<td>Point Source Filter</td>
<td>String</td>
<td>The Point Source Filter string. Asterisk * is a wildcard.</td>
<td></td>
</tr>
<tr>
<td>Data Type Filter</td>
<td>String</td>
<td>The Data Type Filter string. Asterisk * is a wildcard.</td>
<td></td>
</tr>
<tr>
<td>Point Class Filter</td>
<td>String</td>
<td>The Point Class Filter string. Asterisk * is a wildcard.</td>
<td></td>
</tr>
<tr>
<td>Attribute List</td>
<td>String</td>
<td>The Tag Attribute(s) to retrieve</td>
<td>#3 &amp; #4</td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The number of Tags to retrieve</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Attribute List field</td>
<td>#4</td>
</tr>
</tbody>
</table>

Table 8: PI Tag List Input Parameters

Note #1

You can set the Authmode parameter to one of two values depending how you want to authenticate yourself with the PI System:

- **“OSIPI”** – pass in this value if you want to authenticate with the PI System using a PI account. You must also provide values in the Username and Password Parameters but leave the Domain Parameter empty.
- **“WINDOWS”** – pass in this value if you want to authenticate with the PI System using a Windows account. There are two further options for how to authenticate:
For Windows Explicit mode, populate the Username, Password and Domain Parameters.
For Windows Integrated mode, leave the Username, Password and Domain Parameters empty. Your current Windows login identity will be used.

**Note #2**

The **Password** can be supplied one of two ways:

- As plain text. Enter the plain text of the password in the **Password** parameter and set the **Encrypted** parameter to False.
- As encrypted text. Use the Password Encryption Tool described in Chapter 12 to encrypt the password, enter the encrypted text in the **Password** parameter and set the **Encrypted** parameter to True.

**Note #3**

The **Attribute List** Parameter takes a delimiter-separated list of PI Tag Attributes that you want to retrieve. For a complete list of PI Tag Attribute names, see the OSIsoft PICommonPointAttributes documentation.

**Note #4**

By default the separator character for the **Attribute List** parameter is a comma. The **List Separator** Input Parameter allows the use of a different character should any of the Attribute names contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the **Attribute List** parameter using a different delimiter
  - "Attribute 1;Attribute 2"
  - "$map("${AttributeList}", ";")"
- Secondly specify the **List Separator** parameter as a semi-colon
  - ";;"
## PI Tag Data

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>String</td>
<td>The OSIsoft PI Server to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use</td>
<td>#1</td>
</tr>
<tr>
<td>Authmode</td>
<td>String</td>
<td>The Authentication Mode to use</td>
<td>#1</td>
</tr>
<tr>
<td>Tag Name</td>
<td>String</td>
<td>The Tag name(s) to retrieve.</td>
<td>#3</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>String</td>
<td>How the data points will be retrieved</td>
<td>#4, #5</td>
</tr>
<tr>
<td>Calculation Basis</td>
<td>String</td>
<td>How the data points will be calculated</td>
<td>#5</td>
</tr>
<tr>
<td>Timestamp Calculation</td>
<td>String</td>
<td>How the timestamp for each calculated data point will be determined</td>
<td>#5</td>
</tr>
<tr>
<td>Summary Duration</td>
<td>String</td>
<td>The time period used when calculating data values</td>
<td>#5</td>
</tr>
<tr>
<td>Start Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>End Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” or “UTC”.</td>
<td>#6</td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The maximum number of data points to retrieve for each Tag</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Tag Name field</td>
<td>#3</td>
</tr>
<tr>
<td>Comments</td>
<td>String</td>
<td>An optional comment that can be used to identify the source of each retrieved data point.</td>
<td></td>
</tr>
</tbody>
</table>

### Note #1

You can set the Authmode parameter to one of two values depending how you want to authenticate yourself with the PI System:

- "OSIPI" – pass in this value if you want to authenticate with the PI System using a PI account. You must also provide values in the Username and Password Parameters but leave the Domain Parameter empty.
- "WINDOWS" – pass in this value if you want to authenticate with the PI System using a Windows account. There are two further options for how to authenticate:
  - For Windows Explicit mode, populate the Username, Password and Domain Parameters.
  - For Windows Integrated mode, leave the Username, Password and Domain Parameters empty. Your current Windows login identity will be used.
Note #2

The **Password** can be supplied one of two ways:

- As plain text. Enter the plain text of the password in the **Password** parameter and set the **Encrypted** parameter to False.
- As encrypted text. Use the Password Encryption Tool described in Chapter 12 to encrypt the password, enter the encrypted text in the **Password** parameter and set the **Encrypted** parameter to True.

Note #3

To retrieve data for multiple Tags, specify the **Tag Name** Input Parameter as a Column, or use a delimiter-separated list.

By default the separator character for the **Tag Name** parameter is a comma. The **List Separator** Input Parameter allows the use of a different character should any of the names in the list contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the **Tag Name** parameter using a different delimiter
  - "Tag 1;Tag 2"
  - "$map("${TagList}", ",;")"
- Secondly specify the **List Separator** parameter as a semi-colon
  - ";;"

Note #4

You can set the **Retrieval Mode** Parameter to one of these values:

- **Actual Values** – returns only actual recorded data points. This mode can only be used with Tags that return numerical data.
- **Interpolated Values** – returns data interpolated to produce the requested number of points. This mode can only be used with Tags that return numerical data.
- **Plot Values** – returns data enhanced to look good on a chart plot.
- **Snapshot** – returns the current Snapshot value of the Tag data.
- **Total, Average, Minimum, Maximum, Range, StdDev, PopulationStdDev, Count, PercentGood** - return one or more calculated values between the Start Time and End Time, based on the Calculation Basis, Timestamp Calculation and Summary Duration settings.
**Note #5**

When using a Calculated Method, to determine the exact behavior of the **Calculation Basis**, **Timestamp Calculation** and **Summary Duration** parameters for the specific calculation being used, please refer to the OSIsoft API documentation for the PIPoint.Summaries() method:


**Note #6**

You can set the **Timezone** parameter to one of two values depending how you want to retrieve data value timestamps from the PI System:

- **“Local”** – pass in this value if you want the data value timestamps to be displayed in the timezone of your Spotfire client. In the case of Spotfire Web Player and Automation Services, this will be the timezone in which those servers are located.
- **“UTC”** – pass in this value if you want the data value timestamps to be displayed in Co-ordinated Universal Time.
## PI Calculations

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server</td>
<td>String</td>
<td>The OSIsoft PI Server to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use</td>
<td>#1</td>
</tr>
<tr>
<td>Authmode</td>
<td>String</td>
<td>The Authentication Mode to use</td>
<td>#1</td>
</tr>
<tr>
<td>Expression</td>
<td>String</td>
<td>OSIsoft Performance Equation expression</td>
<td>#3</td>
</tr>
<tr>
<td>Include No Sample Values</td>
<td>String</td>
<td>Whether to include data points that did not return a value</td>
<td>#4</td>
</tr>
<tr>
<td>Calculation Mode</td>
<td>String</td>
<td>How the data points will be retrieved</td>
<td>#5 - #10</td>
</tr>
<tr>
<td>Sample Interval</td>
<td>String</td>
<td>See Notes</td>
<td>#7 &amp; #9</td>
</tr>
<tr>
<td>Sample Times</td>
<td>String</td>
<td>See Notes</td>
<td>#8</td>
</tr>
<tr>
<td>Summary Duration</td>
<td>String</td>
<td>See Notes</td>
<td>#9</td>
</tr>
<tr>
<td>Summary Type</td>
<td>String</td>
<td>See Notes</td>
<td>#9</td>
</tr>
<tr>
<td>Calculation Basis</td>
<td>String</td>
<td>See Notes</td>
<td>#9</td>
</tr>
<tr>
<td>Sample Type</td>
<td>String</td>
<td>See Notes</td>
<td>#9</td>
</tr>
<tr>
<td>Timestamp Calculation</td>
<td>String</td>
<td>See Notes</td>
<td>#9</td>
</tr>
<tr>
<td>Start Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>End Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” or “UTC”.</td>
<td>#10</td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The maximum number of data points to retrieve for each Tag</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Sample Times field</td>
<td>#8</td>
</tr>
<tr>
<td>Comments</td>
<td>String</td>
<td>An optional comment that can be used to identify the source of each retrieved data point.</td>
<td></td>
</tr>
</tbody>
</table>

**Table 10: PI Tag Data Input Parameters**

### Note #1

You can set the **Authmode** parameter to one of two values depending how you want to authenticate yourself with the PI System:

- **"OSIPI"** – pass in this value if you want to authenticate with the PI System using a PI account. You must also provide values in the Username and Password Parameters but leave the Domain Parameter empty.
• “WINDOWS” – pass in this value if you want to authenticate with the PI System using a Windows account. There are two further options for how to authenticate:
  o For Windows Explicit mode, populate the Username, Password and Domain Parameters.
  o For Windows Integrated mode, leave the Username, Password and Domain Parameters empty. Your current Windows login identity will be used.

Note #2

The Password can be supplied one of two ways:

• As plain text. Enter the plain text of the password in the Password parameter and set the Encrypted parameter to False.
• As encrypted text. Use the Password Encryption Tool described in Chapter 12 to encrypt the password, enter the encrypted text in the Password parameter and set the Encrypted parameter to True.

Note #3

Expression can be any valid OSIsoft Performance Equation expression. For more details and some example expressions see the following OSIsoft KB article:

KB00464 - PI Performance Equation (PE) Tips and Tricks

Note #4

Performance Equation syntax allows the return of a NoOutput() value instead of the original value. This is typically used in an if/then statement, for example:

if ‘sinusoid’ > 50 then ‘sinusoid’ else NoOutput()

In this case, the retrieved data will still contain a row for each data point, with the items that match the else clause having a Text Value of “No Sample”.

Checking this option will limit the Spotfire data set to only those values the match the if clause, effectively pre-filtering the retrieved data set.

Note #5

The Calculation Mode Parameter can be set to one of the following values:
• **Calculate At Recorded Values** – the expression is evaluated at each point in time (in the given time range) where a recorded value exists for any specified member.

• **Calculate At Intervals** – the expression is evaluated at fixed time intervals over the specified time range

• **Calculate At Times** – the expression is evaluated one or more specific times

• **Calculate Summaries** – the time range is divided into a number of summary intervals. The expression is then evaluated to produce a summary result for each time interval.

For more documentation, refer to the following OSIsoft API Documentation:

[AFCalculation Methods](#)

**Note #6**

When using the **Calculate at Recorded Values** method, the **Expression**, **Start Time** and **End Time** parameters control data retrieval.

See [AFCalculation.CalculateAtRecordedValues Method](#) for more details.

**Start Time** and **End Time** form the **timeRange** parameter and can be any valid AFTIME string.

**Note #7**

When using the **Calculate at Intervals** method, the **Expression**, **Sample Interval**, **Start Time** and **End Time** parameters control data retrieval.

See [AFCalculation.CalculateAtIntervals Method](#) for more details.

**Sample Interval** forms the **sampleInterval** parameter and can be any valid string representation of an AFTIMEInterval.

**Start Time** and **End Time** form the **timeRange** parameter and can be any valid AFTIME string.

**Note #8**

When using the **Calculate at Times** method, the **Expression** and **Sample Times** parameters control data retrieval.
See **AFCalculation.CalculateAtTimes Method** for more details.

**Sample Times** is expanded (if required) using the **List Separator** parameter to form the *times* parameter. Each entry can be any valid *AFTime* string.

**Note #9**

When using the **Calculate Summaries** method, the **Expression**, **Summary Duration**, **Summary Type**, **Calculation Basis**, **Sample Type**, **Sample Interval**, **Timestamp Calculation**, **Start Time** and **End Time** parameters control data retrieval.

See **AFCalculation.CalculateSummaries Method** for more details.

**Start Time** and **End Time** form the *timeRange* parameter and can be any valid *AFTime* string.

**Summary Duration** forms the *summaryDuration* parameter and can be any valid string representation of an *AFTimeInterval*.

**Summary Type** forms the *summaryType* parameter.

**Calculation Basis** forms the *calculationBasis* parameter.

**Sample Type** forms the *sampleType* parameter.

**Sample Interval** forms the *sampleInterval* parameter and can be any valid string representation of an *AFTimeInterval*.

**Timestamp Calculation** forms the *timeType* parameter.

**Note #10**

You can set the **Timezone** parameter to one of two values depending how you want to retrieve data value timestamps from the PI System:

- **“Local”** – pass in this value if you want the data value timestamps to be displayed in the timezone of your Spotfire client. In the case of Spotfire Web Player and Automation Services, this will be the timezone in which those servers are located.
- **“UTC”** – pass in this value if you want the data value timestamps to be displayed in Co-ordinated Universal Time.
Appendix C – Asset Framework Data Function Input Parameters

The Input Parameters to this Data Function vary according to the Mode parameter. The following sections detail the Input Parameters required for each setting of the Mode parameter.

Mode “Elements”

In this mode, the Data Function will retrieve metadata for a list of Element IDs. The fields returned will be as described in Appendix A under AF Element Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Elements”</td>
<td></td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>ID(s) of AF Element(s) to retrieve</td>
<td>#3</td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Element ID field</td>
<td>#3</td>
</tr>
</tbody>
</table>

Table 11: Mode “Elements” Input Parameters

Note #1

OSIsoft AF only supports Windows Authentication. There are two options for how to authenticate:

- For Windows Explicit mode, populate the Username, Password and Domain Parameters.
- For Windows Integrated mode, leave the Username, Password and Domain Parameters empty. Your current Windows login identity will be used.

Note #2

The Password can be supplied one of two ways:

- As plain text. Enter the plain text of the password in the Password parameter and set the Encrypted parameter to False.
• As encrypted text. Use the Password Encryption Tool described in Chapter 12 to encrypt the password, enter the encrypted text in the Password parameter and set the Encrypted parameter to True.

Note #3

By default the separator character for the Element ID parameter is a comma. The List Separator Input Parameter allows the use of a different character should any of the IDs contain a comma.

To specify a different separator character, for example semi-colon:

• First specify the Element ID parameter using a different delimiter
  o "ID 1;ID 2"
  o "$map("${ElementList}", ";")"
• Secondly specify the List Separator parameter as a semi-colon
  o ";;"
Mode “Attributes”

In this mode, the Data Function will iterate over the list of supplied Element IDs and return metadata for any Attributes that match by Attribute Name or Attribute ID. The special case of “*” for Attribute Name will return all Attributes for each Element.

The fields returned will be as described in Appendix A under AF Attribute Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Attributes”</td>
<td></td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>ID of AF Element(s) to retrieve Attributes for</td>
<td>#3</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>Name of AF Attribute(s) to retrieve</td>
<td>#3 &amp; #4</td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Element ID and Attribute Name fields</td>
<td>#3</td>
</tr>
</tbody>
</table>

Table 12: Mode “Attributes” Input Parameters

**Note #1 and #2**

These parameters behave the same as mode “Elements”.

**Note #3**

By default the separator character for the **Element ID** and **Attribute Name** parameters is a comma. The **List Separator** Input Parameter allows the use of a different character should any of the IDs contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the **Element ID** and **Attribute Name** parameters using a different delimiter
  - "ID 1;ID 2" / "Attribute 1;Attribute 2"
  - "$map("${ElementList}"", ";")" / "$map("${AttributeList}"", ";")"
- Secondly specify the **List Separator** parameter as a semi-colon
  - ";"
The Attribute Name search is Case Sensitive. Both the Attribute Name and Attribute ID fields will be matched against this parameter.

Supplying "*" as the Attribute Name will list all Attributes for each Element.
Mode “Data”

In this mode, the Data Function will iterate over the list of supplied Element IDs and return Data for any Attributes that match by Attribute Name or Attribute ID. The special case of “*” for Attribute Name will return data for all Attributes for each Element.

The fields returned will be as described in Appendix A under AF Attribute Data.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Data”</td>
<td></td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>ID of AF Element(s) to retrieve Data for</td>
<td>#3</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>Name of AF Attribute(s) to retrieve data for</td>
<td>#3 &amp; #4</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>String</td>
<td>How the data points will be retrieved.</td>
<td>#5</td>
</tr>
<tr>
<td>Calculation Basis</td>
<td>String</td>
<td>How the data points will be calculated</td>
<td>#6</td>
</tr>
<tr>
<td>Timestamp Calculation</td>
<td>String</td>
<td>How the timestamp for each calculated data point will be determined</td>
<td>#6</td>
</tr>
<tr>
<td>Summary Duration</td>
<td>String</td>
<td>The time period used when calculating data values</td>
<td>#6</td>
</tr>
<tr>
<td>Start Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>End Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” or “UTC”.</td>
<td>#7</td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The maximum number of data points to retrieve for each Attribute.</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Element ID and Attribute Name fields</td>
<td>#3</td>
</tr>
<tr>
<td>Comments</td>
<td>String</td>
<td>An optional comment that can be used to identify the source of each retrieved data point.</td>
<td></td>
</tr>
</tbody>
</table>

Table 13: Mode “Data” Input Parameters

**Note #1 and #2**

These parameters behave the same as mode “Elements”.

**Note #3**

To retrieve data for multiple Elements or Attributes, specify the Element ID and/or Attribute Name Input Parameter as Columns, or use a delimiter-separated list.
By default the separator character for the Element ID and Attribute Name parameters is a comma. The List Separator Input Parameter allows the use of a different character should any of the items in the list contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the Element ID and Attribute Name parameter using a different delimiter
  - "ID 1;ID 2" / "Attribute 1;Attribute 2"
  - "$map("${ElementList}", ";")" / "$map("${AttributeList}", ";")"
- Secondly specify the List Separator parameter as a semi-colon
  - ";;

**Note #4**

The Attribute Name search is Case Sensitive. Both the Attribute Name and Attribute ID fields will be matched against this parameter.

Supplying "*" as the Attribute Name will retrieve data for all Attributes for each Element.

**Note #5**

When retrieving Attribute Data, you can set the Retrieval Mode Parameter to one of these values:

- **Actual Values** – returns only actual recorded data points. This mode can only be used with Tags that return numerical data.
- **Interpolated Values** – returns data interpolated to produce the requested number of points. This mode can only be used with Tags that return numerical data.
- **Plot Values** – returns data enhanced to look good on a chart plot.
- **Snapshot** – returns the current Snapshot value of the Tag data.

**Note #6**

When using a Calculated Method, to determine the exact behavior of the Calculation Basis, Timestamp Calculation and Summary Duration parameters for the specific calculation being used, please refer to the OSIsoft API documentation for the PIPoint.Summaries() method:
Note #7

You can set the **Timezone** parameter to one of two values depending how you want to retrieve data value timestamps from the PI System:

- **"Local"** – pass in this value if you want the data value timestamps to be displayed in the timezone of your Spotfire client. In the case of Spotfire Web Player and Automation Services, this will be the timezone in which those servers are located.
- **“UTC”** – pass in this value if you want the data value timestamps to be displayed in Co-ordinated Universal Time.
**Mode “Templates”**

In this mode, the Data Function will return a list of Templates defined in a given AF Database.

The fields returned will be as described in Appendix A under AF Template Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Templates”</td>
<td></td>
</tr>
</tbody>
</table>

*Table 14: Mode “Templates” Input Parameters*

**Note #1 and #2**

These parameters behave the same as mode “Elements”.

**Note #3**

The Database Name is Case In-Sensitive.
**Mode “ElementsByTemplate”**

In this mode, the Data Function will return a list of Elements in a given AF Database that are based on a given Template. Options include defining a starting Element for the search and deciding whether to search Descendants.

The fields returned will be as described in Appendix A under AF Element Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Templates”</td>
<td></td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>Optional starting point for search</td>
<td>#4</td>
</tr>
<tr>
<td>Template Name</td>
<td>String</td>
<td>Template Name(s) to search for</td>
<td>#5</td>
</tr>
<tr>
<td>Search Full Hierarchy</td>
<td>String</td>
<td>Whether to search Descendants</td>
<td>#6</td>
</tr>
<tr>
<td>Num Points</td>
<td>String</td>
<td>Maximum number of Elements to return</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Template Name field</td>
<td>#5</td>
</tr>
</tbody>
</table>

*Table 15: Mode “ElementsByTemplate” Input Parameters*

**Note #1 and #2**

These parameters behave the same as mode “Elements”.

**Note #3**

The Database Name is Case In-Sensitive.

**Note #4**

If the Element parameter is empty, then the search begins at the root of the given AF Database.

**Note #5**

To retrieve data for multiple Templates, specify the **Template Name** Input Parameter as a Column, or use a delimiter-separated list.
By default the separator character for the Template Name parameter is a comma. The List Separator Input Parameter allows the use of a different character should any of the names in the list contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the Template Name parameter using a different delimiter
  - "Template 1;Template 2"
  - "${TemplateList},;"
- Secondly specify the List Separator parameter as a semi-colon
  - ";"

Note #6

If the Search Full Hierarchy parameter is True, then any Elements that are Descendants of the Starting Element will also be searched.

If the Search Full Hierarchy parameter is False, then the search will be restricted to the Starting Element and its immediate Children.

For more detailed information on the behavior of this parameter, see the searchFullHierarchy parameter of the AFElement.FindElement() method in the OSIsoft AF SDK:

Mode “Categories”
In this mode, the Data Function will return a list of Categories defined in a given AF Database.

The fields returned will be as described in Appendix A under AF Category Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Categories”</td>
<td></td>
</tr>
</tbody>
</table>

Note #1 and #2

These parameters behave the same as mode “Elements”.

Note #3

The Database Name is Case In-Sensitive.
Mode “ElementsByCategory”

In this mode, the Data Function will return a list of Elements in a given AF Database that are in a given Category. Options include defining a starting Element for the search and deciding whether to search Descendants.

The fields returned will be as described in Appendix A under AF Element Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Templates”</td>
<td></td>
</tr>
<tr>
<td>Element ID</td>
<td>String</td>
<td>Optional starting point for search</td>
<td>#4</td>
</tr>
<tr>
<td>Category Name</td>
<td>String</td>
<td>Category Name to search</td>
<td>#5</td>
</tr>
<tr>
<td>Search Full Hierarchy</td>
<td>String</td>
<td>Whether to search Descendants</td>
<td>#6</td>
</tr>
<tr>
<td>Num Points</td>
<td>String</td>
<td>Maximum number of Elements to return</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Category Name field</td>
<td>#5</td>
</tr>
</tbody>
</table>

Table 17: Mode “ElementsByCategory” Input Parameters

Note #1 and #2

These parameters behave the same as mode “Elements”.

Note #3

The Database Name is Case In-Sensitive.

Note #4

If the Element parameter is empty, then the search begins at the root of the given AF Database.

Note #5

To retrieve data for multiple Categories, specify the Category Name Input Parameter as a Column, or use a delimiter-separated list.
By default the separator character for the **Category Name** parameter is a comma. The **List Separator** Input Parameter allows the use of a different character should any of the names in the list contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the **Category Name** parameter using a different delimiter
  - "Category 1;Category 2"
  - "$map("${CategoryList}", ";")"
- Secondly specify the **List Separator** parameter as a semi-colon
  - ";"

**Note #6**

If the Search Full Hierarchy parameter is True, then any Elements that are Descendants of the Starting Element will also be searched.

If the Search Full Hierarchy parameter is False, then the search will be restricted to the Starting Element and its immediate Children.

For more detailed information on the behavior of this parameter, see the searchFullHierarchy parameter of the AFEElement.FindElement() method in the OSIsoft AF SDK:

Appendix D – Event Frame Data Function Input Parameters

The Input Parameters to this Data Function vary according to the Mode parameter. The following sections detail the Input Parameters required for each setting of the Mode parameter.

Mode “EventFrames”

In this mode, the Data Function will retrieve metadata for a list of Event Frame IDs, with the special case of “**” returning all Event Frames across all Databases. The fields returned will be as described in Appendix A under AF Event Frame Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“EventFrames”</td>
<td></td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>ID(s) of AF Event Frame(s) to retrieve or * to retrieve all.</td>
<td>#4, #5</td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Event Frame ID field</td>
<td>#6</td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The maximum number of Event Frames to retrieve.</td>
<td></td>
</tr>
</tbody>
</table>

Table 18: Mode “EventFrames” Input Parameters

Note #1

OSIsoft AF only supports Windows Authentication. There are two options for how to authenticate:

- For Windows Explicit mode, populate the Username, Password and Domain Parameters.
- For Windows Integrated mode, leave the Username, Password and Domain Parameters empty. Your current Windows login identity will be used.

Note #2

The Password can be supplied one of two ways:
• As plain text. Enter the plain text of the password in the **Password** parameter and set the **Encrypted** parameter to False.
• As encrypted text. Use the Password Encryption Tool described in Chapter 12 to encrypt the password, enter the encrypted text in the **Password** parameter and set the **Encrypted** parameter to True.

**Note #3**

The Database Name is Case In-Sensitive.

**Note #4**

Specifying **Event Frame ID** as “*” will retrieve all Event Frames across all AF databases. In this case, the **Database** parameter is not used.

Using “*” in conjunction with limiting results using **Num Points** is not guaranteed to produce meaningful results as the order of return is not guaranteed.

**Note #5**

To retrieve data for multiple Event Frames, specify the **Event Frame ID** Input Parameter as a Column, or use a delimiter-separated list.

**Note #6**

By default the separator character for the **Event Frame ID** parameter is a comma. The **List Separator** Input Parameter allows the use of a different character should any of the IDs in the list contain a comma.

To specify a different separator character, for example semi-colon:

• First specify the **Event Frame ID** parameter using a different delimiter
  - "ID 1;ID 2"
  - "$map("${EventFrameList}" , ";")"
• Secondly specify the **List Separator** parameter as a semi-colon
  - ";;"
Mode “Attributes”

In this mode, the Data Function will iterate over the list of supplied Event Frame IDs and return metadata for any Attributes that match by Name, with the special case of “*” returning all Attributes.

The fields returned will be as described in Appendix A under AF Event Frame Attribute Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Attributes”</td>
<td></td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>ID(s) of AF Event Frame(s) to retrieve Attributes for</td>
<td>#3</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>Name(s) of AF Attribute(s) to retrieve, or * to retrieve all.</td>
<td>#4</td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Event Frame ID and Attribute Name fields</td>
<td>#3</td>
</tr>
</tbody>
</table>

Table 19: Mode “Attributes” Input Parameters

Note #1 and #2

These parameters behave the same as mode “EventFrames”.

Note #3

By default the separator character for the Event Frame ID and Attribute Name parameters is a comma. The List Separator Input Parameter allows the use of a different character should any of the names contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the Event Frame ID and Attribute Name parameters using a different delimiter
  - "ID 1;ID 2" / "Attribute 1;Attribute 2"
  - "$map("${EventFrameList}", ";")" "$map("${AttributeList}", ";")"
- Secondly specify the List Separator parameter as a semi-colon
  - ";;"
**Note #4**

The Attribute Name search is Case Sensitive. Supplying “*” as the Attribute Name will list all Attributes for each Event Frame.

**Mode “EventFramesAndAttributes”**

The parameters, behavior and output fields of this mode follow mode “Attributes” except that in mode “EventFramesAndAttributes”, Event Frames with no attributes will also be returned.
Mode “Data”

In this mode, the Data Function will iterate over the list of supplied Event Frame IDs and return Data for any Attributes that match by Name, with the special case of “*” returning all Attributes.

The fields returned will be as described in Appendix A under AF Event Frame Attribute Data.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Data”</td>
<td></td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>ID(s) of AF Event Frame(s) to retrieve Data for</td>
<td>#3</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>Name(s) of AF Attribute(s) to retrieve data for, or * to retrieve all</td>
<td>#3 &amp; #4</td>
</tr>
<tr>
<td>Retrieval Mode</td>
<td>String</td>
<td>How the data points will be retrieved.</td>
<td>#5</td>
</tr>
<tr>
<td>Start Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>End Time</td>
<td>String</td>
<td>An OSIsoft PI date/time string.</td>
<td>Appendix E</td>
</tr>
<tr>
<td>Timezone</td>
<td>String</td>
<td>“Local” or “UTC”.</td>
<td>#6</td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The maximum number of data points to retrieve for each Attribute.</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Event Frame ID and Attribute Name fields</td>
<td>#3</td>
</tr>
</tbody>
</table>

Table 20: Mode “Data” Input Parameters

Note #1 and #2

These parameters behave the same as mode “EventFrames”.

Note #3

By default the separator character for the Event Frame ID and Attribute Name parameters is a comma. The List Separator Input Parameter allows the use of a different character should any of the names contain a comma.

To specify a different separator character, for example semi-colon:
• First specify the **Event Frame ID** and **Attribute Name** parameters using a different delimiter
  o "ID 1;ID 2" / "Attribute 1;Attribute 2"
  o "$map("${EventFrameList}", ";")" "$map("${AttributeList}", ";")"

• Secondly specify the **List Separator** parameter as a semi-colon
  o ";;"

**Note #4**
The Attribute Name search is Case Sensitive. Supplying "**" as the Attribute Name will list all Attributes for each Event Frame.

**Note #5**
When retrieving Attribute Data, you can set the **Retrieval Mode** Parameter to one of these values:

• **Actual Values** – returns only actual recorded data points. This mode can only be used with Tags that return numerical data.
• **Interpolated Values** – returns data interpolated to produce the requested number of points. This mode can only be used with Tags that return numerical data.
• **Plot Values** – returns data enhanced to look good on a chart plot.
• **Snapshot** – returns the current Snapshot value of the Tag data.

**Note #6**
You can set the **Timezone** parameter to one of two values depending how you want to retrieve data value timestamps from the PI System:

• "**Local**" – pass in this value if you want the data value timestamps to be displayed in the timezone of your Spotfire client. In the case of Spotfire Web Player and Automation Services, this will be the timezone in which those servers are located.
• "**UTC**" – pass in this value if you want the data value timestamps to be displayed in Co-ordinated Universal Time.
**Mode “Templates”**

In this mode, the Data Function will return a list of Event Frame Templates defined in a given AF Database.

The fields returned will be as described in Appendix A under AF Event Frame Template Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“Templates”</td>
<td></td>
</tr>
<tr>
<td>Num Points</td>
<td>Integer</td>
<td>The maximum number of Templates to retrieve</td>
<td></td>
</tr>
</tbody>
</table>

*Table 21: Mode “Templates” Input Parameters*

**Note #1, #2 and #3**

These parameters behave the same as mode “EventFrames”. 
Mode “EventFramesByTemplate”

In this mode, the Data Function will return a list of Event Frames in a given AF Database that are based on a given Template. Options include defining a starting Event Frame for the search and deciding whether to search Descendants.

The fields returned will be as described in Appendix A under AF Event Frame Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search.</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“EventFramesByTemplate”</td>
<td></td>
</tr>
<tr>
<td>Event Frame ID</td>
<td>String</td>
<td>Optional starting point for search</td>
<td>#4</td>
</tr>
<tr>
<td>Template Name</td>
<td>String</td>
<td>Name(s) of Template(s) to retrieve Event Frames for, or * to retrieve all</td>
<td>#5, #6</td>
</tr>
<tr>
<td>Search Full Hierarchy</td>
<td>String</td>
<td>Whether to search for Event Frame Descendants</td>
<td>#7</td>
</tr>
<tr>
<td>Num Points</td>
<td>String</td>
<td>Maximum number of Event Frames to return</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Template Name field</td>
<td>#6</td>
</tr>
</tbody>
</table>

Table 22: Mode “EventFramesByTemplate” Input Parameters

Note #1, #2 and #3

These parameters behave the same as mode “EventFrames”.

Note #4

If the Event Frame parameter is empty, then the search begins at the root of the given AF Database.

Note #5

Specifying the Template Name parameter as “*” will retrieve Event Frames for all Templates.

Note #6
By default the separator character for the Template Name parameter is a comma. The List Separator Input Parameter allows the use of a different character should any of the names contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the Template Name parameter using a different delimiter
  - "Template 1;Template 2"
  - "$map("${TemplateList}"", ";")"
- Secondly specify the List Separator parameter as a semi-colon
  - ";"

**Note #7**

If the Search Full Hierarchy parameter is True, then any Event Frames that are Descendants of the Starting Event Frame will also be searched.

If the Search Full Hierarchy parameter is False, then the search will be restricted to the Starting Event Frame and its immediate Children.

For more detailed information on the behavior of this parameter, see the searchFullHierarchy parameter of the AFEventFrame.FindEventFrames () method in the OSIsoft AF SDK:

Mode “TemplateAttributes”
In this mode, given a list of AF Templates, the Data Function will return a list of Attributes that match by Attribute Name. Options include returning all Attributes by specifying “*” and deciding whether to search Descendants.

The fields returned will be as described in Appendix A under AF Event Frame Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>“TemplateAttributes”</td>
<td></td>
</tr>
<tr>
<td>Template Name</td>
<td>String</td>
<td>Name(s) of Template(s) to retrieve Attributes for, or * to retrieve all</td>
<td>#4</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>String</td>
<td>Name(s) of AF Attribute(s) to retrieve, or * to retrieve all</td>
<td>#5</td>
</tr>
<tr>
<td>Num Points</td>
<td>String</td>
<td>Maximum number of Event Frames to return</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Template Name and Attribute Name fields</td>
<td>#6</td>
</tr>
</tbody>
</table>

Table 23: Mode “EventFramesByTemplate” Input Parameters

Note #1, #2 and #3
These parameters behave the same as mode “EventFrames”.

Note #4
Specifying the Template Name parameter as “*” will retrieve the requested Attributes for all Templates.

Note #5
Specifying the Attribute Name parameter as “*” will retrieve all Attributes for each of the requested Templates.

Note #6
By default the separator character for the **Template Name** and **Attribute Name** parameters is a comma. The **List Separator** Input Parameter allows the use of a different character should any of the names contain a comma.

To specify a different separator character, for example semi-colon:

- First specify the **Template Name** or **Attribute Name** parameters using a different delimiter
  - "Template 1;Template 2"
  - "$map("${TemplateList}"", ";")"
- Secondly specify the **List Separator** parameter as a semi-colon
  - ";;"
Mode “Search”

In this mode, one or more Event Frames can be returned by searching using an AF Search string.

An example of such a search string would be:

Template:'Event' Start:='*-3d' |Level:>=45.0

For more detailed information on the behavior and syntax of this parameter, see the AFEVENTFRAMESEARCH method of the AFEVENTFRAMESEARCH class in the OSIsoft AF SDK:


The fields returned will be as described in Appendix A under AF Event Frame Metadata.

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Spotfire Data Type</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>String</td>
<td>The OSIsoft PI System to Connect to</td>
<td></td>
</tr>
<tr>
<td>Username</td>
<td>String</td>
<td>The Username to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Password</td>
<td>String</td>
<td>The Password to use.</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Encrypted</td>
<td>Boolean</td>
<td>Indicates whether Password field is encrypted</td>
<td>#1 &amp; #2</td>
</tr>
<tr>
<td>Domain</td>
<td>String</td>
<td>The Windows Domain to use.</td>
<td>#1</td>
</tr>
<tr>
<td>Database</td>
<td>String</td>
<td>The AF Database to search</td>
<td>#3</td>
</tr>
<tr>
<td>Mode</td>
<td>String</td>
<td>&quot;TemplateAttributes&quot;</td>
<td></td>
</tr>
<tr>
<td>Search</td>
<td>String</td>
<td>Name(s) of AF Attribute(s) to retrieve, or * to retrieve all</td>
<td>#5</td>
</tr>
<tr>
<td>Num Points</td>
<td>String</td>
<td>Maximum number of Event Frames to return</td>
<td></td>
</tr>
<tr>
<td>List Separator</td>
<td>String</td>
<td>Separator character for Template Name and Attribute Name fields</td>
<td>#6</td>
</tr>
</tbody>
</table>

Table 24: Mode “EventFramesByTemplate” Input Parameters

Note #1, #2 and #3

These parameters behave the same as mode “EventFrames”. 
Appendix E – Valid Date/Time Formats

Any string that can be used as a constructor for an AFTim e object can be used. This includes:

- Specific Times – 01:23:47 pm, 14:22:11
- Full Date/Time - Sat, 01 Nov 2008 19:35:00 GMT
- Relative Dates, Times and Date/Times - Sat, 01 Nov 2014 19:35:00 GMT + 2y+5d-12h+30.55s
- OSIsoft PI Syntax - *, *-2H, *-3D etc.

Here are some examples of valid declarations:

- "*" (now)
- "*-8h" (8 hours ago)
- "01" (first of current month)
- "01/01" (first of current year)
- "Monday+8h"
- "Sat, 01 Nov 2008 19:35:00 GMT + 2y+5d-12h+30.55s"
- "Today" (Today at 00:00)
- "T-3d"
- "Yesterday + 03:45:30.25"

For full details of the available options, you can consult the AFSDK documentation entry on the AFTim e Constructor.

NOTE: The * notation cannot be used in languages other than English. However, in other languages, locale appropriate terms can be used.

For example “Today” and “Now” work in English work as expected, as do “Heute” and “Jetzt” in German.
Appendix F – Troubleshooting Guide

No menu item to open data from OSIsoft PI or AF

Check that the following steps have been taken:

A. Your system administrator has installed the plugin SPK files on the Spotfire Server that you connect to.
B. You have accepted the updates (you will need to restart Spotfire if it is already running)
C. Your System Administrator has licensed you to use one or more of the Datasources.

Your system administrator must also update the Web Player deployment before you can use files from the library that were built using the Datasources.

Error Message when opening data from PI or AF (Spotfire Analyst)

In this situation you have the plugin SPK files installed but you do not have the required OSIsoft AF Client library installed. Install the “OSIsoft PI AF Client 2015” and restart Spotfire to resolve this issue.
Error Message when opening a DXP file containing data from PI or AF

Most likely the DXP file contains linked data created using the Custom Datasource and one of the two previous issues is preventing you from accessing the data.

See the previous two items. Make sure you can connect to OSIsoft PI or AF before attempting to open the file.

Error Notification when creating a Details View

This is an indication that the required OSIsoft AF Client library is not installed.
**Missing Method Error Message when retrieving data from PI or AF**

ImportException at Spotfire.Dxp.Data:
Failed to execute data source query. (HRESULT: 80131500)

Stack Trace:
- at Spotfire.Dxp.Data.DataSourceConnection.ExecuteQuery2()
- at SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData.NoRowsDataSource.CreateReader(IServiceProvider serviceProvider)
- at Spotfire.Dxp.Data.DataSourceConnection.ExecuteQuery2()
- at Spotfire.Dxp.Data.DataSourceConnection.ExecuteQuery2()

...

MissingMethodException at SpotfirePS.Framework.OSIPIDataSource:
Method not found: 'OSIsoft.AF.Asset.AFValue OSIsoft.AF.PI.PIPoint.CurrentValue()'. (HRESULT: 80131513)

Stack Trace:
- at SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData.DataRowReaderImpl.createIterators()
- at SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData.DataRowReaderImpl..ctor(DataSourceImpl datasource)
- at SpotfirePS.Framework.OSIPIDataSource.DataSource.TagData.OSIPIDataSourceConnection.ExecuteQueryCore2()
- at Spotfire.Dxp.Data.DataSourceConnection.ExecuteQuery2()

This indicates than an older version of the OSIsoft AF Client library is installed. Update to the latest 2015 version to resolve this issue.

**Missing Data or Data Tables in Web Player**

There are multiple possible reasons for this:

1) The Custom Data Source extensions have not been deployed to the Web Player.
   If this is the case, you may see the following error message in the Web Player log file:

   Source: Missing extension
   Extension name: SpotfirePS.Framework.OSIPIDataSource.DataSource.TagList.DataSourceImpl...

   Check the instructions in Section 2 on installation and on updating the Web Player instance(s).

2) The DXP file was setup to use Windows Integrated with OSIsoft PI / AF and there is an issue with the configuration.
   If this is the case you will see error messages in the Web Player log file and Notifications in the Web Player UI indicating that a login failure occurred.
See Section 13 for instructions on how to use Windows Integrated Authentication with Web Player and Automation Services instances.

**Problems connecting to a PI Collective**

If a user attempts to connect to a PI Server that they have not previously connected to, Spotfire attempts to setup a new connection. This is not always successful in the case of PI Collectives. Typically this will result in a “winsock” or “unknown host” error similar to the following, although the error number may vary:

![Figure 74: Error Message when connecting to a PI Collective](image)

The solution here is to use the PI System Management Tool to export the connection information from a working system and import it into the failing system. It may be necessary to delete the faulty entry before importing.

**Blank Timestamp and Timezone Values in Tag Data**

This occurs when the timestamp read from PI is invalid. This has been observed during periods covered by Daylight Saving Time transitions.

The Spotfire log file should contain more detailed information about the timestamp that caused the error.